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ADS 2008 Release Notes

This document describes new features, functionality, fixed issues, and known defects in Advanced Design System
2008. It also identifies errors and omissions in the documentation and provides workarounds for defects wherever
possible. The following table shows the version history for this document.

Version Date Revised/New Issue Title

Initial Release Jan 2008

For more information concerning known issues in Advanced Design System 2008, or to report a new issue, refer to the



Advanced Design System 2008

Agilent EEsof Knowledge Center at: https://edasupportweb.soco.agilent.com

Update and Maintenance Software Releases

Update releases provide specific new features plus all the fixed issues normally found in a Maintenance Software
Release (MSR). Since the Update release contains all the fixed issues of the MSR, MSRs will no longer be available.

An Update release is an entirely new installation of ADS and is installed in its own directory. Therefore, if disk space is
an issue, uninstall your previous version of ADS before installing an Update. If disk space is not an issue, you can
install an update release in its own directory. Although your ADS 2008 licenses will work with ADS 2008 Update
releases, you may need additional licenses to run multiple releases concurrently.

What's New in ADS 2008

Advanced Design System (ADS) 2008 is a major new release of the ADS platform that provides 100% productivity
improvements throughout your design flow. From better project management to easier navigation and editing of your
schematic and layout designs, ADS 2008 enhances your productivity every day.

In addition, this release also provides significant speed improvements to both electromagnetic and circuit simulation.

ADS 2008 also includes the latest enhancements to all of the important new technology introduced following the
release of ADS 2006A with the ADS 2006 Updates.

Speed and productivity enhancements include:

e improved project management, real-time zoom and pan, interactive 3-D layout viewing, stretching, and cut
planes;

e improved LVS (layout vs. schematic) design synchronization, providing full control over the automation to
guarantee the correct layout;

¢ updated design rule checking and fast, accurate artwork export/import for a smoother transition from design to
production;

o full 3-D electromagnetic integration into ADS, for designers who increasingly need electromagnetic analysis for
complete communications product design. The integrated Electromagnetic Design System also contains a faster
bond wire drawing interface;

¢ the latest multi-processor computing, including support for today's 64-bit processors; and
faster high-frequency Transient simulations, providing average speed improvements of up to 6x for large circuits.

General Information
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For more details about what's new in ADS 2008, refer to the Agilent EEsof product page at

http://www.agilent.com/find/eesof-products.
The full set of ADS 2008 installation DVDs can be found in the Knowledge Center.

e Download the appropriate DVD-image for the platform that you wish to install ADS on. To do this, you will need
use DVD writer software to create DVDs from the .iso files.

e New codewords are required for ADS 2008. Please Request Codewords at:
http://eesof.tm.agilent.com/forms/coderegform.html

e To install ADS 2008, please refer to the ADS 2008 Installation Manual.

Fixed Issues

Licensing Fixed Issues

e EDA00186532 — Now only one bundle is used when running remote simulations from the same user when using
the EMX daemon via EEDAEMON_SOCKET.

e EDA00186339 — The disconnection/reconnection behavior has been re-worked for ADS 2008. The new behavior
allows one to attempt to reconnect to the license server as many times as desired, instead of only five retries as
in previous releases. Now only a single "Retry or Exit" dialog is displayed along with a final confirmation dialog
when reconnection is re-established.

e EDA00076250 — License Preference Tool no longer incorrectly detects a Ul license in pb_design_guides.

Design Environment Fixed Issues

EDA00076298 — ADS windows now scroll properly when the window is on a second monitor.

e EDA00191192 & EDA00191505 — Reading a huge GMDIF file or a multi-dimension GMDIF file with huge number
of data points on outer dimensions was extremely slow. The reading performance has been tremendously
improved.

e EDA00186901 — The command line driven standalone program ds_export crashed with some dataset files. The
problem is now fixed.

e EDA00076550 — CITI file reader didn't read data from certain CITI files properly. The defect is now fixed.

Data Display

e EDA00184036 — When a DDS window is resized, its contents now change size, similar to the way the schematic
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changes size when a schematic window is resized.

EDA00180973, EDA00179889, EDA00183318, & EDA00191199 — 64-bit DDS is introduced in ADS 2008 release,
and is able to read in dataset size greater than 2GB.

Physical Design

EDA00183999, EDA00180602, & EDA00183997 — DXF import and export is now improved and more stable.
Issues like; incorrect layer numbers after exporting to DXF and the re-importing it, incorrect colors after DXF
import, inability to handle spaces in the path name, have been resolved.

Analog/RF Simulation Fixed Issues

EDA00186050 — Implemented singular matrix safeguards in phase noise simulation.

EDA00076659 — Phase noise specification for frequency domain sources (P_1tone, I1tone, V1tone, etc) is now
correctly applied when the phase of the large signal tone is not equal to 0.

EDA00186624 — BSIM3 in NQS mode is more robust in nonlinear noise simulations.

EDA00183182 — SnP simulation is no longer slow when two or more SnP components read the same dataset file.

EDA00187435 — Tuning and sweeps now use case-insensitive matching on parameter names.

EDA00186840 — A new Power Probe component makes it easy to compute power anywhere in the circuit.

EDA00191323 — Some circuits with diodes now simulate much faster in transient.

EDA00187081 — Agilent HBT is more robust in transient simulations.

EDA00181228 — For node names that contain special characters and have bus notation, quoted bus names are
now accepted.

EDA00182706 — Nodesets now work correctly in DC.

EDA00177198 — "Seed" is no longer only dependent on the machine time. As a result, for swept Monte Carlo
analysis, each Monte Carlo has different seed so that the random variables are truly random, no matter how fast
the simulation goes.

EDA00154143 — The interpretation of line continuations in spectre-language netlists now matches more closely
to the interpretation used by the spectre simulator.
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EDA00076938 — TOM1 model converges faster in HB.
EDA00076544 — LSF 6.2 is now supported for distributed circuit simulations.

EDA00076278 — New syntax is added to allow DC operating points from encrypted designs and netlists.
IP_Encoder is also updated to include such functionality.

EDA00076270 — Fixed a problem when using an expression for VtSine's Phase parameter.
EDA00076246 — "Specify nodes" is the default oscillator analysis mode.

EDA00192627 — If a netlist is chosen in the wizard that uses .option scale, it will create a VAR component with a
value set for _Scale equivalent to the value that is seen in the HSPICE netlist. If a VAR component already exists
with _Scale defined, you will be asked if you want to update the value so it matches what is in the spice file.

It is up to the circuit designer to use the .option scale correctly. Because _Scale is a global in ADS, it affects all
circuit items that have length and width parameters. If _Scale is placed because of an HSPICE netlist, it will
affect other circuit items that are in the same circuit as the HSPICE component.

You can only have one _Scale variable set in a circuit design. If you have two or more HSPICE components that
use conflicting .option scale values, the circuit will not simulate properly.

EDA00187535 — S2PMDIF component with multiple dimensional data where the independent variable was not
numeric failed in ADS 2006A. This has been fixed in ADS 2006A UR3 and ADS 2008.

EDA00186374 — Hicum 2.21 and 2.22 have better HB convergence properties in NQS mode.

EDA00187122 — IBIS models with two pairs of V-T tables with the same v_fixture values and different r_fixture
values were considered invalid in ADS 2006A. They are valid in ADS 2008.

EDA00192509 — MLIN2 defaults to Mod=1 when the Mod parameter is out of bounds.

EDA00192016 — For a spectre-language sectional include, the "section"..."endsection" lines in the library file will
be recognized even if the "library"..."endlibrary" lines are missing.

EDA00191925 — The scaling parameters SCALE, TC1, and TC2 in the E-element and the G-element controlled
sources of POLE or LAPLACE type are applied by ADS simulator consistently in all simulation types. This may
cause discrepancies across different simulators in transient simulations (some simulators ignore the scaling in
transient simulations but do apply the scaling to AC or DC simulations).

EDA00190913 — When a Bsource instance is set up to read a current from a device, it can now read that current
from either a device, or an inline subcircuit.

EDA00191923 — When a parsing problem is discovered, the line number and file name are reported in more
situations.
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e EDA00182471 — When a circuit fails to converge in harmonic balance, the simulator reports the non-converging
node and harmonic.

e EDA00191432 — The spectre-language pwr() function is now available.

e EDA00187777 — For spectre-language netlists, the precedence of the ~ operator has changed, to match Spectre
6.x results.

e EDA00187388 — Doe Results are now correct when Min=Max in DoeGoal.

e EDA00183097 — Some issues involving the co-optimization of circuit parameters and parameterized Layout
Components were fixed. When you have problems optimizing a pre-2008 Layout Component's geometric
parameters in ADS 2008, you might need to recreate the Layout Component, re-place it in the circuit where it is
used, clean out its database and re-fill its database (this happens automatically while simulating).

e EDA00177217 — Simulated Annealing Optimizer is added into ADS/RFDE for large scale and global optimization
problems.

e EDA00075989 — Post-production tuning now resolves the conflict outputs in dataset from leaf analysis and ppt
itself.

e EDA00187275 — Unused model cards are not flattened, to reduce simulation time and memory usage.
e EDA00186242 — The flattener has better performance for circuits with a large number of node names.

e EDA00186988, EDA00076485, EDA00076498, & EDA00182976 — Substantial improvements have been made in
netlist handling. Parsing will now complete faster and use less memory. Sectional includes and line continuations
in spectre-language netlists are processed faster and produce results more consistent with Spectre's results.

e EDA00186699 — Tuning no longer fails when referencing tunable items from sub-circuits that have have been
deleted from the project.

e EDA00192786 — Circuit corruption no longer occurs when a sweep or optimization moved a BinModel device
from one bin to another.

Nonlinear Devices

e EDA00192817 — BSIMSOI applies the global scale parameter.
e EDA00190855 — Model flag FIngs works properly in Hicum L2.21 and Hicum L2.22.

e EDA00179644 — The Temp parameter is listed for EE_HEMT1.
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e EDA00076838 — Model BSIM4: In release 2006A, controlling voltages for Cgd were mistakenly used for Cgs
calculation. This is now fixed.

e EDA00076705 — Temperature scaling of the parameters A1, Cgs, and Cgd in Curtice cubic model is corrected.

User Compiled Models

e EDA00186523 — ADS now helps Analog UserCompiled Model users set up environment variables for Microsoft
.NET compiler on Windows.

e EDA00186112 — The makefile for Analog UserCompiled Model hpeesofdynamic.mak was obsolete in ADS 2006A.
For a command line UserCompiled Model, please refer to the following link
https://edasupportweb.soco.agilent.com/portal/page? pageid=36,39953& dad=portal& schema=PORTAL&itemid=30757

Verilog-A

e EDA00192400 — To run VerilogA simulations on Windows Vista 64, you must install Microsoft Visual Studio 2005
- the default installation, the Service Pack SP1, and the hotfix to the SP1.
The Service Pack and its corresponding hotfix can be downloaded from Microsoft's website at

ADS Ptolemy Simulation Fixed Issues

EDA00184136 — Initial conditions (InitCond) no longer crash Ptolemy-transient co-simulations.

e EDA00185702 — The TimedSource component now always reads the last sample in a dataset file.

e EDA00184127 — The BiquadCascade component now simulates properly with more than one defined biquad in
the DSP Schematic.

e EDA00183752 & EDA00172111 — The Analog/RF source components no longer work intermittently in
'Sources-Modulated-DSP-Based'.

e EDA00182515 — The HDL cosimulation speed was restored to where it was in ADS/RFDE 2004 in this release.

e EDA00075942 — Problem with HDL Cosimulation simulation failures is fixed in this release.
Some HDL cosimulations were successful in ADS/RFDE 2004 but not in ADS/RFDE 2005/2006. HDL cosimulation
success is restored for those designs in ADS/RFDE 2008.

e EDA00184426 — Dynamic Link 2008 users can select component pins in Cadence schematic window for the
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current to be saved after simulation. The usage is similar to the existing feature of saving node voltages in
Cadence schematic window for Dynamic Link simulation. A tutorial example in the manual illustrates the use
model.

Momentum Fixed Issues

e EDA00192609 — Possible access violation when processing vias is now fixed. Hotfix available for ADS2006
Update 3.

Wireless Design Libraries Fixed Issues

e EDA00190574 — Enhancement:
° Add new sources (WMAN_M_DL_Src_AllCoded and WMAN_M_DL_Src_AllCoded_RF) in which all the bursts
are encoded and the allocation for DL-MAP and UL-MAP is more flexible.
° Update the test bench WMAN_OFDMA_DL_VSA with the new RF source.

DesignGuides Fixed Issues

EDA00183816 — The Impedance Matching utility now allows the source and load impedance to be defined as
N-port data files (touchstone, citifile or dataset).

e EDA00182873 — You are now notified when the reactive components of the source or load are absorbed into the
synthesized network, which apparently changes the order of the synthesized network but is actually the correct
approach.

e EDA00181858 — The overview instructions were expanded in the Passive Circuit DesignGuide, Filter
DesignGuide, the Impedance Matching utility, and the Bias utility. Where appropriate, it adds instructions on
placing an MSUB component, and it also describes the toolbar icon that activates the palette in the schematic
window.

EDA00076459 — An enhancement was implemented to allow negative values for L and C components.

Passive Circuit

e EDA00186397 — For the Passive Circuit Designguide, if the user specifies a bandwidth of a microstrip circuit that
is too small or too large, the Designguide will issue a warning telling the user that the specifications are out of
range for what one would typically use for the topology.

e EDA00181757 — Previously, the progress indicator on the Design tab of the Passive Circuit DesignGuide would
go to 100% and then quickly be reset to 0% after the design was complete. Now, it stays at 100% until you
either 1) press the design button again or 2) change the current smartcomponent.
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Smith Chart

EDA00182700 — In the Smith Chart utility, the number of digits in the readout were reduced for Z, Y, Gamma,
and VSWR for better viewing.

e EDA00182178 — The Smith Chart utility now allows a second trace to be displayed in the Network Response
plot.

e EDA00100600 & EDA00181563 — The File > Save function in the Smith Chart utility has been updated to save
more information about the smith chart setup.

e EDA00100599 — The underlying snap grid in the Smith Chart has been improved to make the setting of
parameter values more exact, preventing snap-to-grid errors.

e EDA00076461 — The Smith Chart utility now allows circles values of 2, which are set with the View > Chart
Options menu.

Known Issues

Installation Known Issues

On Solaris 10, ADS does not run properly with Sun recommended patch bundle installed

ADS 2008 does not run properly with Sun recommended patch bundle dated 9/27/07 or 11/06/07.
Workaround:
Install required patches listed in Operating System Details in the System Requirements section.

RFIP Encoder fails to install on Windows Vista Enterprise Edition

EDA00193037 — If you try to install ADS 2008 on a PC running Windows Vista Enterprise Edition, you will get a setup
failed message. Under the Business Edition of Vista, this error is not seen and at this point in time, we're not officially
supporting the Enterprise edition.

On Windows Vista with UAC turned, an AEL error appears at ADS startup

EDA00188175 — On Windows Vista, if you installed ADS while User Account Control (UAC) is turned on, you will get
an AEL error when you start ADS for the first time and the HOME directory will not be writable.

Workaround:

Under Windows Vista with UAC turned on, if you share the system with in a lab or if many users access a single
system, you need to open up the security permissions on the "HOME" directory/folder setting for ADS.
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On Linux and UNIX, more than one license bundle is pulled

EDA00186798 — On Linux and UNIX, if the DISPLAY environment variable is not set properly, there is a potential to
pull more than one license bundle for certain simulators on multi-processor and multi-core machines.

Workaround:

Set the DISPLAY environment variable correctly to resolve this issue.

On Windows, users of cygwin scripts can see errors do to extra line feed characters

On Windows, users of cygwin scripts can see errors do to extra line feed characters. The error messages seen includes
": syntax error near unexpected token" or "syntax error at... line .., near" " tiburonda"
Workaround:

1. Installing Cygwin from the cygwin web site:
http://www.cygwin.com/

2. Running dos2unix < script file name > where the utility dox2unix can be found under < installation dir >/
tools/bin directory

USB dongles are not currently supported on Linux

ADS 2006A is unable to support USB dongles on Linux at the present time. The latest version of FLEXnet 10.8.0.10
incorporated into ADS 2006A does not work with USB dongles on Linux 32/64-bit platforms. Macrovision is currently
working on a fix for this problem.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Installation.1712

Value of HOME variable in Environment Variables must match value in registry

EDA00127078 — To run properly, on the Windows platform, the HOME variable set in the environment must match
the value stored in:

HKEY_LOCAL_MACHI NE\ Sof t war e\ Agi | ent\ ADS\ 3. 3\ eeenv\ HOVE

This registry value is normally set during the installation process.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Licensing.412

Canceling the Uninstall Program on Windows Systems

The uninstall program on Windows may be very slow. If you cancel the uninstall program, you may encounter
problems reinstalling ADS.
Workaround:
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For ADS 2003C and earlier versions:

1. Delete the ADS installation folder. For example, select C:\ADS2003C using Windows Explorer then press the shift
and delete keys. Select yes to confirm deletion of read-only and program files.

2. After the installation folder is deleted, select Start > Programs > Advanced Design System (version) > Uninstall
ADS.

For ADS 2004A and newer versions:

1. Delete the ADS installation folder. For example, select C:\ADS2004A using Windows Explorer then press the shift
and delete keys.

2. Reboot the PC.

3. Run ADS Uninstall using one of the following methods:

o If you have access to the ADS CD ROMs, insert the PC Setup Program Disk1 into the disk drive. This should
auto-launch the ADS installer. Select Remove to start the unistall process.
e If you DO NOT have access to the ADS CD ROMs, select Start > Run, type the following command, then press OK

C: \ PROGRA~1\ COVMMON~1\ | NSTAL~1\ Dri ver\ 9\ | NTEL3~1\ | Dri ver . exe
/ M A9ABAC9B- 45C9- 4026- 81EC- 1C3FOF72BFFF}

#» Note The space must be preserved in the preceeding typed command.

api_set_menu_accelerator() does not work

EDA00193070 — If the specified accelerator key has already been assigned to a menu, the
api_set_menu_accelerator() does not work.

Workaround:

Create a custom menu configuration file, and then go in manually and remove the api_set_menu_accelerator() that
contains the desired accelerator key. This will cause that accelerator key to NOT be defined, and can therefore be
assigned by the user. This feature will be fixed in ADS 2008 Update 1.

Mouse cursor flickers on Linux

EDA00181097 — On Linux, if the windows manager option is set to: Point in Window to make Active, and several
modal dialogs are open, it is possible that the mouse cursor will flicker.

Workaround:

Set the windows manager option, Click in Window to make Active and unset Point in Window to make Active. The key
here is whether to click or point. Some shells refer to this process as " Focus follows mouse' or " Click to focus'.

The location of the window manager options and descriptions may vary depending on the shell being used. Look for
the area where windows style preferences or behavior can be set.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Layered API.1442
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Design Environment Known Issues

Design file corrupted on saving

If you run out of disk space while saving a design on UNIX, the design file may get corrupted. The corrupted file may
cause ADS to fail when you open the design.

Workaround:

To avoid this problem, check your available disk space. Make sure you have sufficient disk space before running ADS.

Unarchiving .zap files on UNIX with insufficient disk space

ADS may hang if you attempt to unarchive an archived (. zap ) project on UNIX and do not have sufficient disk space.

Workaround:
Ensure that you have sufficient disk space before unarchiving a large project (a large amount of RAM is also required).
If necessary, try renaming the .zap file with a .z extension and use the unzip utility to decompress the project file.

Information on library_group is lost when design is copied

If you copy a design for which you have defined a library (the Library Name field in File > Design Parameters ), the
library information will be lost.

Workaround:

Open the copied design, choose File > Design Parameters, and enter the desired library name in the Library Name
field. Alternatively, you can manually edit the AEL file to add the desired library name.

Opening multiple designs on Windows

On the Windows platform, ADS will run out of memory if you open multiple design windows.

Workaround:

Whenever possible, open or create designs within the same window. You can set opening and creating designs in an
existing window as your default option by deselecting the New/Open Design in New Window option in the Main
Preference dialog box ( Main window > Options > Preferences ).

Non-orthogonal rotations can put pins off grid

If the rotation increment is not a multiple of 90 degrees, it is possible to get symbol pins off the grid. This typically
happens when the rotation angle is set to 45 degrees. When objects are rotated 45 degrees and then rotated again for
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another 45 degrees, the resulting instances may have their pins slightly off the grid.

Workaround:
It is strongly recommended that users should check the Options > Preferences Entry / Edit Rotation Angle and set it to

90 degrees.

Backward compatibility for designs

Starting with ADS 2003C, you can open Analog/RF designs from subsequent versions of ADS. However, you will not be
able to open Signal Processing designs from subsequent versions.
When opening an Analog/RF design from a subsequent version of ADS:

e The system displays a warning dialog box with a list of instances that were modified including a list of which

parameters were updated.

o If the design from the subsequent version of ADS contains instances of components that did not exist in the
current version of ADS, the system will be unable to find the component definitions for those components. You
must delete these instances or replace them with alternative components.

Data Display

DDS may crash in your RFDE session

EDA00191146 — If you rlogin from an HP-UX 11 machine to a SunOS Sun-Fire machine, DDS may crash in your RFDE
session.

Workaround:

To avoid the problem, try rlogin from a Linux machine or use vnc to connect to the SunOS machine.

Problem with debug mode on the PC

Using the HPEESOF_DEBUG_MODE on the PC may cause the Data Display server to hang. This mode is invoked by the
command hpads_verbose.

Workaround:

If possible, do not use the debug mode on the PC.

Dataset Aliases should only be used to reference static data

EDA00183003 — You should only use Dataset Aliases to view data that is static and not changing during the Data
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Display session. If you use a Dataset Alias to reference trace or equation data, this data will not automatically update
after the simulation completes.

Workaround:

To force data referenced by a Dataset Alias to update, you must close and reopen Data Display window.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=AEL.775

Dataset File Size

In the 2008 release of ADS software (and subsequent releases), the former size limitation on datasets is removed.
Datasets larger than 2 GB are now allowed. However, the use of extremely large datasets is sometimes impractical,
because of issues such as loading time and memory capacity.

 Note

Datasets created by ADS 2008 software (and subsequent releases) are not readable by earlier versions of the
ADS software. For information on how to identify (or convert) the dataset type, see the discussion of Dataset
Types in the UNIX and Linux Installation documentation or the Windows Installation documentation, as

appropriate.

Electronic Notebook

Adding Data Display pages to an existing Electronic Notebook

EDA00180030 — If you attempt to add a Data Display page (using Add Page and the New Notebook Page dialog box)
to an existing notebook, and that page is actually a combination of two or more data display files (such as you might
create using the Smart Simulation Wizard), the Electronic Notebook may crash.

Workaround:
Delete the existing / notebook directory in the project of interest and generate the notebook again.

Physical Design

Disabling Layout connectivity features

It is possible to disable layout connectivity features when there are performance and memory consumption problems
with large designs such as reticles or imported designs. To disable layout connectivity features you must manually edit
de_sim.cfg by adding the following line:

LAYQOUT_PI N_CONNECTI VI TY_ONLY=TRUE

For more information refer to "Checking Connectivity Information" in the Schematic Capture and Layout

documentation.
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Analog/RF Simulation Known Issues

Simulations fail on 64-bit platforms when EESOF_MODEL_PATH is set to incorrect value

EDA00192738 — Simulations may fail on 64-bit platforms due to errors of missing devices when the environment
variable EESOF_MODEL_PATH is set to an incorrect value in the hpeesofsim.cfg file in the project under simulation. An
example of incorrect values is that $ARCH is involved. This problem has only been observed in projects generated in
older versions of ADS.

Workaround:

Delete the line that defines EESOF_MODEL_PATH from the hpeesofsim.cfg file in the specific project. Note that the
hpeesofsim.cfg file under the ADS installation should not be modified.

HSPICE RF statements are not recognized by ADS 2008.

EDA00192430 — ADS 2008 does not recognize HSPICE RF statements.
Workaround:
Comment out these statements before using the HSPICE Compatibility feature of ADS.

AVM Noise Simulation Improvements

Ptolemy/Circuit Envelope co-simulation with AVM: ADS/RFDE 2006A Update Release 2 contains noise simulation
improvements, particularly suitable for 1/f noise. Previous model generated too much noise, or required long
simulation time. User documentation of the new feature is available in the Knowledge Center (search for " AVM Noise
Simulation Improvements ").

IBIS simulation will not proceed with incomplete Driver Schedule data

IBIS simulation will not proceed if the Driver Schedule data in the specified IBIS file is incomplete. While this is
desired when the user wants to use the Driver Schedule, the simulation will not proceed even if the user wants to
simulate the top level model alone by specifying "UseDriverSchedule=no".

Place IBIS files in the project's "data" directory for design portability

When using any of the 19 IBIS components on the "Signal Integrity - IBIS" palette, an "IbisFile" parameter must be
specified. The value of this parameter is the path to an IBIS file, and it is not directly editable. This path will be a
complete path unless the file resides in the project's "data" directory.

If the design will be shared with other users, the recommended location for IBIS files is the project's "data" directory
to ensure portability. Otherwise, other users will not be able to modify the complete path value of the "IbisFile"
parameter without losing instance data.
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Design Kit approach to IBIS simulation is obsolete

The native IBIS model was introduced in ADS 2006 Update 1 release. Starting with ADS 2008, the old design kit
based approach of simulating IBIS models is obsolete. As a result, you will not be able to access the IBIS Library
application guide from the Analog/RF Schematic page. The designs created in earlier releases of ADS will require
replacing the old IBIS model with native IBIS models for a successful simulation

The new native IBIS model in ADS is much faster, more robust, and covers more keywords and model types from the
IBIS specifications. The native IBIS model in ADS can be accessed through the Signal Integrity-IBIS component
library and palette.

The new IBIS models are licensed features and are included by default in all the Signal Integrity Design bundles and
the High Speed Analog Design Suites. If you own one of Signal Integrity Designer bundles or High Speed Analog
Design Suites, you can renew your codewords to include IBIS models without any additional cost. If you own any
other EEsof product bundle, you may need to check with your local EEsof representative on how the new IBIS model
can be added to your current EEsof configuration.

How to turn on passivity enforcement and save impulse response to dataset in convolution

A new functionality has been introduced to enforce passivity in transient analysis for linear frequency domain
components which are simulated using discrete mode convolution. Parameters ImpEnforcePassivity and
EnforcePassivity have been added to the transient controller and SnP component so you can turn on this feature. The
default value for these parameters is no. If ImpEnforcePassivity=yes, ADS corrects passivity violations in all linear
frequency domain components. Similarly, if EnforcePassivity=yes in a SnP component, passivity will be enforced in
that particular device. The EnforcePassivity setting of SnP component overwrites the ImpEnforcePassivity setting of
the transient controller in an individual device.

A new parameter ImpSaveSpectrum has also been added to the transient controller to save the impulse response, its
FFT, and the original spectrum to a dataset if discrete mode convolution is used in transient analysis. The default
value is no. The information added to the dataset uses names similar to those shown here where CMP1 is the
component name:

CMP1_FFT_IMP: FFT of final impulse response used in convolution.

CMP1_IMP: Final impulse response used in convolution.

CMP1_OR: Original spectrum.

CMP1_S0: Exists only if passivity is enforced. Spectrum after causality but before passivity correction.

These new parameters will not be available in setup dialog boxes until the ADS 2008A release. Until then, you can
enable these features using this workaround:

To set ImpEnforcePassivity=yes, select an existing parameter in the transient controller's setup dialog box such as
Integration coefficient mu on the Integration tab. Append ImpEnforcePassivity=yes in its field (you must leave an
empty space after the original value of mu ).
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Use this same method for ImpSaveSpectrum in the transient controller and EnforcePassivity in the SnP component.

Correct operation of Deembed2 in ADS2006A and beyond

The Deembed2 component has been part of ADS for several releases now. The original description of its
functionality/use for negating the behavior of an S2P component, had a discrepancy between the text in Note 3 where
the user is asked to place the component back-to-back with the S2P which is to be neutralized, and the following
figure which clearly shows front-to-back or tandem connection.

In 2006A, when Deembed components with larger number of ports (e.g., Deembed4) were introduced, the
infrastructure of Deembed2 was corrected and aligned with a generic de-embedding algorithm. As a result, the
perceived functionality of Deembed2 had changed. Although it is now correctly negating S2P behavior when placed in
a mirror-ed / back-to-back alignment either before or after the S2P component, the ADS manual still contains the
incorrect figure which is misleading.

To effectively negate the functionality of an S2P component, first horizontally mirror a Deembed2 component and then
either place it to the left of S2P, connecting its Pinl to Pinl of S2P or place it to the right of S2P, connecting the Pin2s
together. These configurations are equivalent and effective in negating or short circuiting the effect of S2P component
in the circuit.

More information about this issue may be found by referrmg to the Agilent EEsof Knowledge Center at:

Problem with user compiled models on 64-bit Windows systems

User compiled models do not work on 64-bit Windows systems.

Workaround:
To get user compiled models to work on 64-bit windows systems :

1. Rename $HPEESOF_DIR/tools/bin to $HPEESOF_DIR/tools/bin32

2. Rename $HPEESOF_DIR/tool/bin_64 $HPEESOF_DIR/tools/bin

3. Check the version of cygwin installed. If it is 1.5.20 or newer no change is required, if it is older, rename
c:\cygwin to c:\cygwin-renamed or any other name.
More information about this issue may be found by referrmg to the Agilent EEsof Knowledge Center at:

The simulation fails due to an undefined UserCompiledModel
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EDA00173639 — In 6A, the shared libraries for user compiled models are now created under the directory,
<current_prj>/userCompiledModel/lib.$SIMARCHDirectory. If the ADS simulation fails due to an error like:

*xxx' is an instance of an undefined model *xxx_model'

Workaround:

This is caused by an incorrect path for "EESOF_MODEL_PATH", set in the file, <current_prj>/hpeesofsim.cfg. This
variable should not be set in this file. However, the current contents may be important, so the easiest way to fix this is
to rename the variable from "EESOF_MODEL_PATH" to "USER_MODEL_PATH". For example, if
<current_prj>/hpeesofsim.cfg contained:

EESOF_MODEL_PATH=. :..:../networks
you would change it to:
USER_MODEL_PATH=. :..:../networks

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Examples.1392

Verilog-A compiled files are version specific

The Verilog-A compiled files (CML files) are compiled when you run the first simulation, or when you run a subsequent
simulation containing a modification of an associated Verilog-A source file.

CML files are version specific. In ADS 2005A version 1.20 is used. To avoid compatibility problems between different
versions, these CML files are placed in the 1.20 folder of the cache directory.

For 2004A simulations the CML files are still located in the 1.12 folder of the cache directory. If you use 2004A, the
appropriate version of the files will be picked up.

PackFFT parameter in HB simulation

The parameter PackFFT controls the frequency map packing for multitone Harmonic Balance. By default, when it is not
explicitly set to "yes' or "no', the simulator enables it (i.e., "yes'). Setting PackFFT to "yes' may improve the
simulation speed and reduce memory consumption by using a smaller number of time samples (smaller FFTs), but at
the potential loss of dynamic range and accuracy due to the aliased harmonics of the first fundamental now possibly
landing on various mixing tones. For mixers and other applications with a single large dominant (LO) tone, that
frequency should be assigned to the first fundamental and PackFFT should be set to "no' so that any aliased
harmonics of this large signal will just land on its own harmonics and not on mixing terms. If you are simulating mixer
intermodulation or third-order intercept, it is recommended that this parameter be set to "no' to achieve the most
accurate results. In ADS, the parameter PackFFT is found on the Display tab of the HB and CE controllers. To set this
parameter in ADS, check it on the Display tab and then set it to “yes' or "no' directly on the schematic. In RFDE,
PackFFT is found in the Options dialog for the HB and Env analyses.

Behavioral Models

Use "Simulate > Stop and Release Simulator...' in the schematic window to abort a simulation
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EDA00131124 — If you stop a simulation from the Simulation Status window and then try to start another simulation,
you may receive an error message stating: " Foreground simulation already running ".

This occurs because the inter-process communication messages (between the schematic editor and the simulation
status window) to stop a simulation are not processed in the right order due to timing issues.

Workaround:

Use the Simulate > Stop and Release Simulator... menu pick in the Schematic window to reset the simulator and allow
further simulations to proceed.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Simulation.10460

Nonlinear Devices

SiMKit 2.4 from NXP and PSP version 102.1, including the NQS version, are fully supported

Starting with ADS 2006 Update 1, SiMKit 2.4 from NXP and PSP version 102.1, including the NQS version, are fully
supported.

Release 2006A contains SiMKit 2.3.2 device library from NXP (Philips Models)

Starting with 2006A the SiMKit device library from NXP (originally Philips) is included in the standard ADS/RFDE
installation. The version contained in 2006A is SiMKit 2.3.2. The library is in the form of a dynamically linked library
(dIl) and is netlist-based. There is no corresponding UI palette in the UI. For further details and a design kit support
for ADS UI please visit the NXP web site at:

http://www.nxp.com/Philips Models/source library/

Transformer and TransformerG obsoleted

The Transformer and TransformerG components have been obsoleted but are still available for backwards
compatibility. To use the features available in these components, substitute the TF component for Transformer and
TransformerG.

Preventing simulation errors in foundry design kits used in circuit design

If a foundry design kit is used in a circuit design, it is recommended that the
ModelInclude/TechInclude/DesignKitInclude component is placed at the top level (i.e., same level as the
TestLab/Sequencer ), and not placed in sub-circuits or individual test benches in order to prevent simulation errors.
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AgilentHBT model DC operating point values are only approximate

The DC operating point values reported for four of the parameters of the AgilentHBT model, Dthx, Dthi, Gmdc_ext and
Gmdc_int, are only approximate, analytical calculations based on the DC solution, and as such they may be inexact or
inaccurate. It should be noted that these parameters in no way affect the validity of the model simulations. They are
only meant to provide supplemental information.

User Compiled Models

Static linked user-compiled model is obsolete in ADS 2008 on all platforms

Starting with ADS 2008, the static linked user-compiled model is obsolete on all supported platforms

User Compiled Models may need recompiling to work in ADS 2008

You may need to recompile user-compiled models so they work with ADS 2008. Here are guidelines to help you decide
if recompiling is necessary:

e Windows users must recompile the model source code and create a new dynamic linked library for Windows

32-bit systems. This is not required for Windows 64-bit systems.
e UNIX users must recompile the model source code and create a new dynamic linked library for Linux systems.

This is not required for Solaris systems.
e Existing 32-bit shared libraries will not work with 64-bit simulators. The converse is also true: 64-bit

user-compiled models cannot be used with 32-bit simulators.

RF System Budget Analysis

Sweep status not reported at every sweep point

EDA00182486 — If the Budget analysis controller is used with a ParamSweep or other parent controller, the current
sweep status is not reported at every sweep point. Although, some ADS controllers like Harmonic Balance do report a
status message (e.g., HB HB1[2/7)]. The Budget controller does not send a status message during simulation. Also,
when a warning or error is reported, the exact sweep point at which the event occurred is not reported.

Budget controller UI measurements tab Add > Apply > Delete empties list
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EDA00180354 — On UNIX and Linux platforms, performing the following steps on the Budget controller UI's
measurements tab clears the list of selected measurements on the dialog box:

1. Select a measurement from the list on the left.

2. Click Add

3. Click Apply

4. Click Delete
This empties the entire list of selected measurements on the right, instead of the highlighted measurement on
the list (the last one added).
Workaround:
Click cancel and undo the last change on the schematic.
More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Simulation.10366

Verilog-A

ADS status window appears frozen during Verilog-A compilation

The ADS status window appears frozen during Verilog-A compilation. This is a known behavior that does not have a
workaround. Do not stop the simulation when you see this behavior. The Verilog-A compilation will finish and the
status window will be updated at that point.

Compilation of large files on HP-UX

Compilation of large files (several thousand lines) on HP-UX is problematic with the supplied gcc compiler. The
workaround is to use the cc compiler that is part of the aCC tool suite. In order to do so, you must have the cc
compiler available on HP-UX. Appendix B of the " Using Verilog-A in ADS/RFDE " manual outlines how to switch from
the gcc to the cc compiler. Note that the cc compiler that ships as part of the operating system will not work.

Lack of CML cache locking mechanisms

When Verilog-A modules are compiled to Compiled Model Library (CML) files, a CML cache directory is used. CML
cache locking mechanisms have not been implemented in this release. This means that it is possible to encounter file
sharing issues if multiple simulations using the same CML cache are run on the same platform at the same time.

Workaround:
To avoid this problem, simulate on two different platforms, simulate sequentially instead of in parallel, or use separate

caches for each simulation.
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Transient simulation speed

The performance of Verilog-A based models relative to corresponding C based models is analysis dependent. For large
Verilog-A files, Transient simulations are generally within a 2X window while the other analyses (DC, AC, Harmonic
Balance, Circuit Envelope) are generally within a 1.5X window. This is significantly faster than traditional interpreted
approaches.

Compile time

The Verilog-A compile time can vary dramatically depending on the size of the Verilog-A file, the platform, and the
processor. For small files on fast machines, it takes a matter of seconds. For huge files on slow machines, it can take
minutes or up to an hour. Note that for simulations taking only a few seconds, the compile time can far exceed the
simulation time. On state-of-the-art hardware, compile time is not a roadblock for most customers.

Remote simulation requires an environment variable to be set

When working in a UNIX environment, you must set the environment variable

AGQ LENT_VERI LOGA_COWPI LER=host nane: agi | ent - vaconp

prior to running the ADS remote simulation daemon (hpremote). The same name can be used as is specified in the
"Remote Host Selection' text box on the "Single' tab of the *Simulation Setup' dialog box.

The “sim_veriloga' license can be pulled when it is not used

The license associated with compilation and loading of Verilog-A modules is * sim_veriloga'. Simulations without
Verilog-A content do not pull the * sim_veriloga ' license. The exception is when a Verilog-A file with a module which
overrides a built-in component is placed in the Verilog-A search path. In this case, the * sim_veriloga ' license will get
pulled, regardless of whether the component is used in the simulation or not.

Verilog-AMS

Enabling Verilog-AMS

EDA00193212 — To use Verilog-AMS with the ADS simulator, you must enable the capability prior to starting ADS. To
enable Verilog-AMS capability, set and export the environment variable ENABLE_VERILOG_AMS. For example:

export ENABLE_VERI LOG AMB=1
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ADS Ptolemy Simulation Known Issues

Dynamic Link 2008 with IC 6.1.0 and IC 6.1.1

EDA00192612 — DC Annotation does not work correctly with ADS 2008 Dynamic Link if you are using Cadence
version IC 6.1.0 and IC 6.1.1. It works correctly with releases prior to IC 6.1.0.

State variables should have unique names for multiple MATLAB blocks/instances

ADS Ptolemy cosimulation with Matlab uses the Matlab COM API. Due to restrictions imposed by Matlab, all Ptolemy
Matlab models or instances of Ptolemy Matlab models share the same session workspace. This means that any state
variables created by one block or instance will be shared across the entire workspace.

This problem is typically encountered when using the Matlab IP Import wizard to create a user-defined Matlab model
that wraps around a Matlab function. For each imported model, the Matlab IP Import wizard creates a subnetwork that
allows the user to enter a Matlab setup string. This is typically used to initialize a workspace variable. For example.,
one could define MatlabSetupStr="x=0". If multiple instances of this block is instantiated, or if another block is
instantiated with MatlabSetupStr="x=0", the order of the initializations is not deterministic. Furthermore, if x is used
to preserve the state between multiple invocations of the Matlab function, it can lead to unexpected behavior.

If there are multiple Matlab models with separate sub-networks, the workaround is to use unique variables to preserve
the state. For example, M1 can have MatlabSetupStr="x=0" and M2 can have MatlabSetupStr="y=0".

If there are multiple instances of the same Matlab model, there is no easy way to preserve state or avoid workspace
variables from being overwritten.

More information about this issue may be found by referrmg to the Agilent EEsof Knowledge Center at:

Multithread simulation on PC only works for DSP designs

Multi-Thread simulation (MT) can speed up ADS simulation. However, there is a limitation on the PC. On a PC this only
works for DSP designs. For Cosim designs there is no speed improvement and the simulation may fail.

Workaround:

Use MT on Linux for Cosim to speed up the simulation.

More information about this issue may be found by referrmg to the Agilent EEsof Knowledge Center at:

Connectivity error when DSP subnetwork uses an iterated port

EDA00184448 — Ptolemy subnetworks do not support iterated ports. If a DSP subnetwork uses an iterated port, a
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connectivity error will be generated.

Workaround:

Connect a Bus component (from the Numeric Control palette) to the port and specify the bus width for the BusWidth
parameter. This creates a single multiport in the subnetwork.

More information about this issue may be found by referrmg to the Agilent EEsof Knowledge Center at:

Red "anytype' pins do not work properly with timed signals

EDA00179269 — Components with “anytype' input pins will not propagate timed signals properly. These "anytype'
components should only be used with numeric signals ( int, float, fixed-point, complex, and matrix). This restriction
applies to the components in the Numeric Control library, such as the Commutator component.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Signal Proc.2274

Misleading error message appears if DF controller is missing

EDA00182055 — When starting a Ptolemy simulation, the following, misleading, error message may appear:

Error detected by HPEESG:SI M during netlist parsi ng
Undefi ned paraneter "DefaultRQut" used by "

This message indicates that the design is missing a DF controller.
More information about this issue may be found by referrmg to the Agilent EEsof Knowledge Center at:

Limitation on naming user-defined models

User-defined Ptolemy models cannot have the same name as standard ADS Ptolemy models. Creating a user-defined
Ptolemy model with the same name as a standard ADS Ptolemy model may cause the simulator to crash when that
model is used.

VSA_89600_Sink models cause Tk plots to hang

If you are using VSA_89600_Sink models in a simulation with Tcl/Tk models and you minimize a Tcl/Tk dialog box or
window you will be unable to reopen that dialog box or window. The result is, you must exit the VSA 89600 software,
which in turn causes ADS to hang, forcing you exit ADS.

Workaround:
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Pause the measurement using the pause icon on the VSA 89600 UI toolbar and then maximize the Tcl/Tk dialog box
or window.

VeelLink component can cause internal error in VEE

Using the Ptolemy Vee Link component on a workstation that has a numeric character as the first letter of the host
name causes an internal error in Vee. For example, if the PC you are using to run a simulation has a host name of
99Agent, the simulation status window will record an error with the text Internal error, specifying the VeeLink
component as the error source.

Workaround:

Change the host name to have an alpha character first (i.e., Agent99 ) or use the IP Address in the HostName field
when configuring the VeelLink component.

ESG/PSG Automatic Level Control (ALC) could fail for bursted signals

EDA00183213 — The CM_ESG_E4438C_Sink and CM_PSG_E8267C_Sink components optionally download an ADS
generated signal to the instrument at the end of the simulation. When certain bursted waveforms are played on the
ESG ARB, the ALC circuitry in the instrument fails to track the power level of the signal, and the output is corrupted.
In such situations, you should see "UNLEVEL" displayed on the ESG front panel.

Workaround:

Turning off ALC from the ESG front panel should help you get the expected ESG RF output.

Components with stringarray state parameters add one extra value

TkButtons, TkShowBooleans and PatGen_16522A_Sink have parameters that automatically add an extra value by
inserting the stringarray state and their default value. These parameters are for labeling purposes but can cause
simulation to fail if the number of labels is different than the number expected.

Workaround:

Assume one extra label is always added and adjust the number of labels accordingly.

Type DataType moved to ADSPtolemy namespace

The type DataType has moved from the global namespace to the ADSPtolemy namespace. This was done to avoid
conflicts with definitions in the Windows.h header. A variable of type DataType now must be declared as:

ADSPt ol eny: : Dat aType nyVar;

instead of

Dat aType nyVar;

When assigning values to an ADSPtolemy:: DataType variable or comparing its value against the predefined data
types (INT, FLOAT, COMPLEX, FIX) the namespace specifier ADSPtolemy:: must be used.
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For example:

if \'( myVar == ADSPtol eny::INT \) \{
\}

An alternative to using the ADSPtolemy:: namespace specifier is to add the line using namespace ADSPtolemy; before
declaring and using ADSPtolemy:: DataType variables.
For example, in the go method you can have:

usi ng nanespace ADSPt ol eny;

Dat aType nyType;

nyType = input.resol vedType\ (\); /1 input is the name of the input port
if \'( myType == INT \) \{

\}
else if \( nmyType == FLOAT \) \{

\}
el se \{

\}

TimedSink does not record swept characterization frequency correctly

This problem occurs in simulations where a signal's characterization frequency is dependent on a swept variable. If
such a signal is saved to the dataset using a TimedSink component, the sink will not record the varying
characterization frequency (saved as attribute fc ) correctly. The characterization frequency that is recorded will be
the same for all sweep points and will be equal to the signal's characterization frequency at the first sweep point.

Incorrect parameter settings of VSA_89600_Source may crash a simulation

EDA00182547 — If the parameters of VSA_89600_Source are incorrectly set, for example, a frequency trace (typically
VSATRace=A) that is set for a timed output (OutputType=Timed), the VSA instance will disconnect itself and the
simulation will become very slow or crash.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Instrument Links.402

Component ‘ReadFilePreProc' does not work with remote simulation

EDA00179175 — Component ReadFilePreProc can only be used with local simulations.
More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Signal Proc.3637
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HDL Cosimulation

Running HDL cosimulation on Windows 64-bit machines in 32-bit compatibility mode

The ADS installer will create tools\bin and tools\bin64 subdirectoriries under your ADS installation are. To successfuly
run HDL cosimulation in 32-bit compatibility mode on Windows 64-bit machines you need to rename the bin directory
to bin32 and the bin64 directory to bin.

HDL Cosimulation in UI mode does not work correctly when used with sweep or optimization

EDA00181522 — If the parameter "HdISimulatorGUI" is set to "On" during a parametric sweep or when optimizing
designs that contain the components HdICosim, NCCosim or VxICosim, HDL Cosimulation will error out after the first
simulation point.

Workaround:

Set the parameter "HdISimulatorGUI" to "Off" during sweep or optimization.
More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Signal Proc.3813

HDL Cosimulation with multi-threaded scheduler may hang-up

EDA00129050 & EDA00183861 — Windows 2000/XP dual processor machines and Solaris machines using any HDL
Cosimulation component, along with the multi-threaded scheduler option set on the DF controller, causes the
Cosimulation to randomly hang.

Workaround:

The solution is to not use multi-threaded simulation on those operating systems for designs that hang-up the
simulation. If the Cosimulation does hang, identify the started processes and manually kill them.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Signal Proc.3863

Examples Known Issues

Accuracy of Jitter Analysis results and memory usage

Jitter Analysis is a statistical based approach that uses a single acquisition technique as opposed to a multiple
acquisition technique. As a result, more bits used (typically millions of bits) ensure better accuracy. When an
insufficient number of bits are used, the RIJrms value and thus TJpp tend to get very large, and the bathtub curve may
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close the eye or intersect too soon. Increasing the number of bits and thus transitions may ensure better results.
Workaround:

In such instances if there are millions of bits, it might exceed the ADS or system memory limitation and run out of
memory. Restricting the number of variables or measurements saved to the data set may alleviate this problem.

Jitter Front Panel

e The DDJR Histogram and DDJF Histogram plots are interchanged.
e Under certain conditions the sliders in the DDJ versus Bits over-lap the plots. However, the sliders are still
functional and can still be used.

IS95A_ChnCodec_prj number of frames tested too small

In the example IS95A_ChnCodec_prj, the number of frames tested in the designs is too small to produce an accurate
BER/FER for a high SNR.

Workaround:

Use a larger number of frames to obtain good BER curves.

CDMA2K_RC_TD_prj examples inconsistent with CDMA 2000 standard

In some examples of forward link in CDMA2K_RC_TD_prj, the scrambling mode by long PN code and the data
mapping for OTD mode are not consistent with the CDMA 2000 standard. You can still use these examples as
references because this inconsistency has little influence on system performance.

PerchCH_prj data slot settings

In the PerchCH_prj example, the .dsn file has a setting for 1000 slots of data, but the associated dataset (.dds) file
was obtained using a setting of 100 slots. Using larger slot numbers provides more accurate results, but leads to
significantly longer simulation times.

Example Search is case insensitive

Example search is not case sensitive. For example, searching for the word " Amplifier " will yield the same results as
searching for the word "amplifier".
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Momentum Known Issues

Momentum optimization parameters are not automatically transformed to Layout Component parameters in ADS 2008.

Parameters defined using the Momentum > Optimization command are not automatically converted into component
parameters in ADS 2008 when the Component Parameters dialog box is opened.

Workaround:

You must use the ADS 2006 release to perform the conversion automatically.

Using the AutoCover Vias feature in 2006A may cause a significant increase in the nhumber of unknowns

In ADS 2006A, the Momentum mesher automatically covers vias when the following conditions are met:

e The via has certain material parameters, Perfect Conductor, Conductivity or Surface Impedance, (for this
example we will call them "Z" parameters) and they go from layer interface A to layer interface B.

e On layer interface A, a microstrip layer is mapped that has the same material as the "Z" parameters.

e On layer interface B, a microstrip layer is mapped that has the same material as the "Z" parameters.

Under these conditions, the Momentum mesher in ADS 2006A will automatically cover the (otherwise hollow) via with
a cover in the same material as the "Z" parameters.

Although a useful layout feature, this can increase the number of unknowns if the layout is not set up optimally.
When you have a via that crosses many dielectric layers (say, N layers), and you defined that via for each of the N
layers (that is, you drew it on N different layout layers that are each mapped as via layers in the Metallization tab)
then the via will get a cover on each of the intermediate layout layers when proceeding conditions are met.

When "edge mesh" is set for all the layers involved, this may lead to a considerable increase of the number of
unknowns.

Momentum enables you to draw a via through many layers, by simply mapping the same via layer to all the dielectric
layers it crosses. In this case, the Momentum mesher only places covers at the real top and the real bottom of that
via, and not on all the intermediate levels.

Workaround:

When comparing ADS 2006A with ADS 2005A, the number of unknowns can be increased simply due to the existence
of the automatically covered vias. If this increase is too high for your simulation, you might consider using the
following environment variable:

MOM_AUTOCOVERVIAS=FALSE

You must add this line to the file $HOME/hpeesof/config/momentum.cfg.

If this file does not exist, you must create it and add MOM_AUTOCOVERVIAS=FALSE to it.

The next time ADS is started and Momentum is run, the autocover vias feature will be disabled.

31



Advanced Design System 2008

Solving in RF mode then plotting S-parameters using the Visualization tool

EDA00183256 — If you try to plot S-parameters using the Visualization option, for a project that was last solved in RF
mode, Visualization may crash. This is true when the S-parameters are in either the CITIfile format or the AFS
(Adaptive Frequency Sweep) format. The problem is caused by the fact that the visualization option is expecting
certain types of data (GAMMA and Z0) that MomentumRF does not generate.

Workaround:

Display the S-parameters obtained from MomentumRF using the ADS Data Display.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Mom UI ADS.1033

Visualization current density off by a factor of 2

EDA00183732 — The actual current density in a plot is 2 times greater than the value reported by Momentum
Visualization.

Stopping Momentum simulation process

EDA00178902 — The Momentum simulation process might not automatically stop after selecting Simulation/Synthesis
> Stop Simulation... in the simulation status window.

Workaround:

Manually terminate the Momentum simulation process from command line.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Mom UI ADS.1010

Visualizing surface currents using discrete arrow plots

The Momentum documentation does not mention that arrow plots enable you to visualize the surface currents using a
vector representation.

On a dense, uniform grid, a vector represents the sampled surface current. Normally, the grid density should be
appropriate. If not, the discrete arrow plot provides another way to look at the surface currents. In a method of
moments solution, your circuit is subdivided into a number of cells.

The surface current on each cell is expanded in a set of basis functions (Momentum uses rooftop basis functions). On
a cell, there is a basis function associated with each edge. The total current on a cell is the linear superposition of all
basis functions with their appropriate amplitude. In the discrete arrow plot, a vector is shown in the middle of all cell
edges representing the basis function amplitude.

Setting absolute limits for layout parameters
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EDA00153107 — You cannot set an absolute upper or lower limit for layout parameters that are defined for
Momentum Layout Components. You should check to see whether or not a specific value is physically meaningful.
More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Mom_UI ADS.1149

Simulating structures with a port on box and layer with thick metal expansion on

The simulation results of structures in a box, where the location of the port is on the box perimeter and on a metal
layer where thick metal expansion is on, will be wrong as this port is shorted.

Workaround:

Don't use thick metal expansion for the metal layer containing the port.

Known problems when using Momentum in Digital Signal Processing Only mode

When ADS is setup in Digital Signal Processing Only mode, the creation of Momentum layout components and the
usage of these components in the schematic environment will generate errors.

Workaround:

Change the ADS setup to * Analog/RF Only ', or * Both, With Default: Analog/RF Design '

Z0 and GAMMA values appear incorrectly in dataset

When selecting the Momentum > Substrate > Create/Modify, Substrate Layers tab, if Permittivity (Er) is set to Re,
Conductivity, GAMMA will not appear in the dataset and the Z0 values will be set to the default of 50 ohms. This
occurs because the port solver was switched off to improve Momentum simulation speed.

To switch the port solver back on, the configuration variable located in, HOME/hpeesof/config/momentum.cfg must be
set as follows:

MOM3D_USE_PORTSOLVER=2

This forces the port solver to run, and the Z0 and GAMMA entries will appear correctly in the dataset.

Tuning Known Issues

Tuning Initialization Can Take Some Time
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When launching Tuning, the initialization can take anywhere from a few seconds to a minute or more depending on
the size of the design hierarchy. Currently, there is no workaround.

Include Opt Params does not include parameters with a space between opt and {

The Include Opt Params feature in Tuning does not include parameters that have a space between the opt and the "
{{{3}} " in their syntax.

Workaround:

To ensure that these parameters are included, edit the parameter and remove the space.

Wireless Design Libraries Release Notes

Fixed WiIMAX Wireless Library

Top Level Models

1. Top-level baseband signal sources and RF signal sources for downlink and uplink were provided. The various
downlink/uplink signal sources can be generated using these top-level signal source models by setting their
parameters. It's very easy for customers.

The functionalities are as follows in the new downlink/uplink sources (WMAN_DL_Src_FD, WMAN_DL_Src_FD_RF,
WMAN_UL_Src_FD and WMAN_UL_Src_FD_RF):

e Configure TDD/FDD frames for downlink and uplink

e Frame duration supported in both downlink and uplink

Flexible configuration of bursts and MAC PDUs

FCH, DL-MAP, UL-MAP, DCD and UCD automatically generated in downlink

2. Top-level baseband receivers and RF receivers for downlink and uplink were also developed. Corresponding to
top-level signal sources, all these top-level receiver models have the same parameters in signal source.
Customers can create their system measurements much simply.

Test Benches

The fixed WIMAX Wireless Library provide test benches of WirelessMAN-OFDM PHY transmitter and receiver. Three
projects (WMAN_OFDM_Tx_prj, WMAN_OFDM_Rx_prj and WMAN_OFDM_FrameDuration_prj) are provided in this
fixed WiMAX WL.

1. WMAN_OFDM_Tx_prj
This library provides transmitter test benches of fixed WiMAX WirelessMAN-OFDM PHY system. The transmitter
measurements are EVM, constellation, spectrum mask and CCDF and etc.
e WMAN_OFDM_DL_TxXEVM.dsn: measure downlink EVM (or RCE) and show the demodulated constellation
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e WMAN_OFDM_DL_TxSpecFlat.dsn: measure downlink transmitter spectral flatness
e WMAN_OFDM_DL_TxWaveform.dsn: measure downlink transmitter CCDF, waveform and spectrum mask

WMAN_OFDM_UL_TxEVM.dsn: measure uplink EVM (or RCE) and show the demodulated constellation

2. WMAN_OFDM_Rx_prj
This library provides receiver test benches of fixed WiMAX WirelessMAN-OFDM PHY system. The receiver
measurements are sensitivity, PER on fading channel and etc.

WMAN_OFDM_DL_AWGN_BER.dsn: measure downlink BER/PER in AWGN environment
WMAN_OFDM_DL_RxSentivity.dsn: measure downlink receiver minimum input level sensitivity
WMAN_OFDM_UL_Fading_BER.dsn: measure uplink BER/PER in fading channel
WMAN_OFDM_UL_RxAdjCh.dsn: measure uplink receiver adjacent and alternate channel rejection

3. WMAN_OFDM_FrameDuration_prj
This project provides some test benches of transmitter and receiver to support frame duration in
WirelessMAN-OFDM PHY system.

WMAN_OFDM_DL_Fading_BER_FD.dsn: measure downlink BER/PER in fading channel with frame duration
WMAN_OFDM_DL_TxXEVM_FD.dsn: measure downlink EVM (or RCE) and show the demodulated
constellation with frame duration

WMAN_OFDM_DL_TxWaveform_FD.dsn: measure downlink transmitter CCDF, waveform and spectrum
mask with frame duration

WMAN_OFDM_UL_AWGN_BER_FD.dsn: measure uplink BER/PER in AWGN environment with frame duration
WMAN_OFDM_UL_SubCh_TxEVM_FD.dsn: measure uplink EVM (or RCE) and show the demodulated
constellation with sub channelization.

Revision History

1. 2005A.100 - December 2005 (Initial release, obsoleted by 2005A.402)
Initial release of fixed WiMAX 802.16 OFDM wireless library.

2. 2005A.402-April, 2006
Update and bug fixed:

Provide new signal sources and receivers to support frame duration in both downlink and uplink.
Develop broadcast message in downlink source. This broadcast message includes DL-MAP, UL-MAP, DCD
and UCD.

Configure TDD/FDD frames for downlink and uplink

Update downlink and uplink sources for consistency with Agilent Signal Studio and 89600 software.

3. 2006A.402 - January 2007
Update to support ADS2006A and later versions

HSDPA Wireless Library

Top Level Models

1. Top-level baseband signal sources and RF signal sources for downlink are provided. Various downlink signals can
be generated using these top-level signal source models by setting their parameters.These are very easy s to

35



Advanced Design System 2008

use. The functionalities are as follows:
e Downlink source with HARQ and AMC functions
e Fixed reference channels Hsetl to Hset6 are pre-configured.
e Downlink source also includes 12.2k 3GPP FDD reference channel and TestModell to TestModel5 except for
HSDPA downlink channels.

2. Top-level baseband receivers and RF receivers for downlink are also developed. Corresponding to top-level signal
sources, all these top-level receiver models have the same parameters as that of the signal source models. With
these models, customers can create their system measurements very easily.

e Downlink receiver capable of processing Hsetl to Hset6
e Downlink receiver capable of processing HS-SCCH.

Test Benches

The HSDPA Wireless Library provides test benches for HSDPA transmitter and receiver measurements. Two projects
(HSDPA_BS_Tx_prj, and HSDPA_UE_Rx_prj) are provided in this HSDPA WL.

1. HSDPA_UE_Rx_prj
This project provides receiver test benches of HSDPA downlink. The receiver measurements include
Demodulation of HS-DSCH, HS-SCCH detection performance and Maximum input power.
e UE_Rx_Demodulation_Hsetl_ PA3_QPSK.dsn: Demodulation of Hsetl with QPSK under PA3
e UE_Rx_Demodulation_Hset2_PB3_16QAM.dsn: Demodulation of Hset2 with 16QAM under PB3
e UE_Rx_Demodulation_Hset3_VA30_16QAM.dsn: Demodulation of Hset3 with 16QAM underVA30
e UE_Rx_Demodulation_Hset4_PB3_QPSK.dsn: Demodulation of Hset4 with QPSK under PB3
e UE_Rx_Demodulation_Hset5_VA120_QPSK.dsn: Demodulation of Hset5 with QPSK under VA120
e UE_Rx_Demodulation_Hset6_PA3_16QAM.dsn: Demodulation of Hset6 with 16QAM under PA3
e UE_Rx_HSSCCH_Detection_TS1_PA3.dsn: HS-SCCH detection performance of test number 1 under PA3
e UE_Rx_Maxlevel.dsn: Maximum input level for HS-PDSCH
2. HSDPA_BS_Tx_prj
This project provides transmitter test benches for HSDPA downlink. The transmitter measurements are ACLR,
CCDF, EVM, maximum output power, occupied bandwidth, peak code domain error, spectrum emission and
connecting with VSA.
e BS_Tx_ACLR.dsn: Adjacent channel leakage(ACLR) of BS transmitter
e BS Tx_CCDF.dsn: CCDF of BS transmitter
e BS_Tx_EVM.dsn: Modulation accuracy of BS transmitter
e BS_Tx_Max_Power.dsn: Maximum output power of BS transmitter
e BS_Tx_OccupiedBW.dsn: Occupied bandwidth of BS transmitter
e BS Tx Pk _Code_Error.dsn: Peak code domain error of BS transmitter
e BS_Tx_SpecEmissions.dsn: Spectrum emissions of BS transmitter
e BS_Tx_VSA.dsn: connecting with VSA

Revision History

1. 2005A.401 - July 2006 (Initial release)
Initial release of HSDPA wireless library.
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HSUPA Wireless Library

Top Level Models

1. Top-level baseband signal sources and RF signal sources for uplink and downlink are provided. Various
downlink/uplink signals can be generated using these top-level signal source models by setting their parameters.
It's very easy for customers to use. The functionalities are as follows:

¢ Uplink source with HARQ function

e Fixed reference channels FRC1 to FRC7 for uplink

¢ Fully-functional 3GPP FDD downlink source including HSUPA downlink channels.
e TTI 2 ms and 10 ms

2. Top-level baseband receivers and RF receivers for downlink and uplink are also developed. Corresponding to
top-level signal sources, all these top-level receiver models have the same parameters as that of the signal
source models. With these models, customers can create their system measurements very easily.

e Uplink receiver for FRC1 to FRC7
e Downlink receiver for HSUPA related channels.
3. Top-level RF measurement models for uplink are developed.
e Qutput power measurement
e EVM measurement
4. Multipath fading channel model for HSUPA and HSDPA is developed

Test Benches

The HSUPA Wireless Library provide test benches of HSUPA transmitter and receiver. Four projects (BS_Rx_prj,
UE_Rx_prj, UE_Tx_prj and HSUPA_RF_Verification_prj) are provided in this HSUPA DL.

1. BS_Rx_prj
This project provides receiver test benches of HSUPA uplink. The receiver performance measurements include
E-DPDCH demodulation performance, E-DPCCH demodulation performance and False alarm possibility in AWGN
channel.
e BS_Rx_Demodulation.dsn: E-DPDCH demodulation performance in AWGN channel
e BS_Rx_MissDetection.dsn: Missed detection possibility of E-DPCCH in AWGN channel
e BS_Rx_FalseAlarm.dsn: False Alarm possibility in detecting E-DPCCH in AWGN channel
e BS_Rx_DemodulationFading.dsn: E-DPDCH demodulation performance in fading channel
e BS_Rx_MissDetectionFading.dsn: Missed detection possibility of E-DPCCH in fading channel
e BS_Rx_FalseAlarmFading.dsn: False Alarm possibility in detecting E-DPCCH in fading channel
2. UE_Rx_prj
This project provides receiver test benches of HSUPA Downlink. The receiver measurements include
demodulation performance of E-AGCH, E-RGCH, E-HICH.
e UE_Rx_EAGCH_Demodulation.dsn: Demodulation of E-DCH Absolute Grant Channel (E-AGCH)
e UE_Rx_ERGCH_Detection.dsn: Detection of E-DCH Relative Grant Channel (E-RGCH)
e UE_Rx_EHICH_Detection.dsn: Detection of E-DCH HARQ ACK Indicator Channel (E-HICH)
e UE_Rx_EAGCH_DemodulationFading.dsn: Demodulation of E-AGCH in fading channel
e UE_Rx_ERGCH_DetectionFading.dsn: Detection of E-RGCH in fading channel
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e UE_Rx_EHICH_DetectionFading.dsn: Detection of E-HICH
3. UE_Tx_prj
This project provides transmitter test benches of HSUPA downlink. The transmitter measurements are output
power, EVM, spectrum emission, ACLR and CCDF.

UE_Tx_Max_Power.dsn: Maximum output power of UE transmitter
UE_Tx_SpecEmissions.dsn: Spectrum emissions of UE transmitter
UE_Tx_ACLR.dsn: Adjacent channel leakage(ACLR) of UE transmitter
UE_Tx_EVM.dsn: Modulation accuracy and phase discontinuity of UE transmitter
UE_Tx_CCDF.dsn: CCDF of UE transmitter

. HSUPA_RF_Verification_prj
The HSUPA_RF_Verification_prj project shows on how to build a WTB (Wireless Test Bench) like application with
"Summary" data display page.
e HSUPA_UE_Tx_test.dsn: HSUPA Tx WTB include maximum power, adjacent channel leakage power ratio

(ACLR), peak code domain error (PCDE), error vector magnitude (EVM).

Revision History

. 2005A.401 - January 2005 (Initial release, obsoleted by 2005A.402)
Initial release of HSUPA wireless library.

. 2005A.402-July, 2006
Enhancement:

Support FRC2 - FRC7 in Uplink receiver.

Add HSPA multipath fading channel

Support both uplink and downlink performance test in fading channel

Add six new examples for fading channel performance.

Updated maximum output power measurement

Create new EVM model to test EVM and phase discontinuity

Using latest spec. (2006-3)

Bug fixed:

HSUPA_ChDecode was not robust in handling the condition in extreme high SNR
HSUPA_CHDecode bugs in range checking when the parameter TC_Iteration is out of range
Rate match is updated to meet the physical channel and spreading factor limitation for each UE category
defined in 25.306

Mobile WiMAX 802.16e OFDMA Wireless Library

The Agilent EEsof mobile WiIMAX 802.16e OFDMA Wireless Library (WL) is for the mobile WiMAX (802.16e) market.
This WL follows IEEE Std 802.16-2004 and IEEE 802.16e-2005. This design library focuses on WirelessMAN-OFDMA
PHY (section 8.4) in IEEE Std 802.16-2004 and IEEE 802.16e-2005 and is intended to be a baseline system to help
designers see what a nominal or ideal system performance would be.
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With this library, you can develop and refine algorithms at the system level, where design choices have the greatest
impact. Mobile WiMAX OFDMA signal processing algorithms help you move quickly to implementation. Using seamless
links to other Advanced Design System (ADS) options, in particular analog/RF circuits and DSP implementation, you
quickly verify your design based on specification.

The mobile WiMAX 802.16e OFDMA WL is an Agilent Ptolemy add-on package based on Advanced Design System
2006A.

The mobile WiMAX 802.16e OFDMA WL package includes basic mobile WiMAX 802.16e OFDMA components,
application examples, as well as all software needed to run in Advanced Design System. After installation, the mobile
WiMAX 802.16e OFDMA WL is available in the Signal Processing Schematic window from the "WMAN 16e" library
group and palette.

The mobile WiMAX application Examples are available from the Main window by choosing File > Example Project >
examples / WMAN_M.

Top Level Models

1. Top-level baseband signal sources and RF signal sources for downlink and uplink were provided. The various
downlink/uplink signal sources can be generated using these top-level signal source models by setting their
parameters. It's very easy for customers. The functionalities are as follows:

e Configure TDD/FDD frames for downlink, uplink

e Flexible configuration of zones, bursts and MAC PDUs

e 512, 1024, or 2048 FFT sizes

e FCH, DL-MAP, UL-MAP, DCD, UCD and Compressed DL/UL MAP automatically generated in downlink

e PUSC, FUSC and OFUSC Permutation Zone for downlink, PUSC and OPUSC Permutation Zone for uplink
e Channel coding: CC (Convolutional coding) and CTC (Convolutional turbo coding)

¢ Flexible configuration of ranging, fast-feedback and HARQ-ACK channels in uplink source

e STC/MIMO with 2 antennas sources for both downlink and uplink

e Collaborative MIMO (SM) source with one transmit antenna for uplink

2. Top-level baseband receivers and RF receivers for downlink and uplink were also developed. Corresponding to
top-level signal sources, all these top-level receiver models have the same parameters in signal source.
Customers can create their system measurements much simply.

e 512, 1024, or 2048 FFT sizes with variable bandwidths

e CC decoding with soft decision (with channel state information (CSI))
e CTC decoding with soft decision (with channel state information (CSI))
e STC/MIMO decoding (with ZF and MMSE)

Test Benches

The mobile WiMAX 802.16e OFDMA Wireless Library provides test benches of WirelessMAN-OFDMA PHY transmitter
and receiver. Six projects (WMAN_16e_OFDMA_Tx_prj, WMAN_16e_OFDMA_Rx_prj, WMAN_WiBro_prj,
WMAN_16e_OFDMA_RF_Verification_prj, Mobile_WiMAX_MIMO_Tx_prj and Mobile_ WiMAX_MIMO_Rx_prj) are
provided in this WMAN 802.16e OFDMA WL.

1. WMAN_16e_OFDMA_Tx_prj
This library provides transmitter test benches of WMAN 802.16e WirelessMAN-OFDMA PHY system. The
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transmitter measurements are EVM, constellation, spectrum mask and CCDF and etc.
e WMAN_OFDMA_DL_TxEVM.dsn: measure downlink EVM (or RCE) and show the demodulated constellation
e WMAN_OFDMA_DL_TxEVM_PhaseNoise.dsn: measure downlink EVM (or RCE) and show the demodulated
constellation in phase noise environment
e WMAN_OFDMA_DL_TxWaveform.dsn: measure downlink transmitter CCDF and waveform (preamble, FCH,
bursts etc.).
e WMAN_OFDMA_DL_VSA.dsn: VSA 89600 software analyzes downlink signal source.
e WMAN_OFDMA_DL_TxSpectrum.dsn: measure downlink transmitter spectrum.
¢ WMAN_OFDMA_DL_TxSpecFlat.dsn: measure downlink transmitter spectral flatness.
¢ WMAN_OFDMA_UL_TxEVM.dsn: measure uplink EVM (or RCE) and show the demodulated constellation.
e WMAN_OFDMA_UL_TxSpectrum.dsn: measure downlink transmitter spectrum mask.
e WMAN_OFDMA_UL_VSA.dsn: VSA 89600 software analyzes uplink signal source.
. WMAN_16e_OFDMA_RX_prj
This library provides receiver test benches of WMAN WirelessMAN-OFDMA PHY system. The receiver
measurements are sensitivity, PER on fading channel and etc.
e WMAN_OFDMA_DL_Fading_BER.dsn: measure downlink BER/PER in fading channel
e WMAN_OFDMA_DL_RxSentivity.dsn: measure downlink receiver minimum input level sensitivity
¢ WMAN_OFDMA_DL_RxAdjCh.dsn: measure downlink adjacent and alternate channel rejection
¢ WMAN_OFDMA_UL_AWGN_BER.dsn: measure uplink BER/PER in AWGN channel
. WMAN_WiBro_prj
This library provides transmitter and receiver test benches of Korea WiBro system. The measurements are EVM,
BER on AWGN channel and etc.
e WiBro_DL_AWGN_BER.dsn: measure WiBro downlink BER/PER in AWGN channel
e WiBro_DL_TXEVM.dsn: measure WiBro downlink EVM (or RCE) and show the demodulated constellation.
e WiBro_UL_TxEVM.dsn: measure WiBro uplink EVM (or RCE) and show the demodulated constellation.
e WiBro_UL_VSA.dsn: VSA 89600 software analyzes WiBro uplink signal source.
. WMAN_16e_OFDMA_RF_Verification_prj
This library provides transmitter and receiver WTB of 802.16e OFDMA WirelessMAN-OFDMA PHY system. The
measurements are EVM, constellation, BER and etc.
e WMAN_DL_802_16e_TX_test.dsn: measure downlink transmitter performances, such as EVM (or RCE),
constellation, waveform and etc.
e WMAN_UL_802_16e_TX_test.dsn: measure uplink transmitter performances, such as EVM (or RCE),
constellation, waveform and etc.
e WMAN_DL_802_16e_RX_Sensitivity_test.dsn: measure downlink receiver sensitivity
e WMAN_UL_802_16e_RX_Sensitivity_test.dsn: measure uplink receiver sensitivity
. Mobile_ WiMAX_MIMO_Tx_prj
This library provides transmitter test benches of Mobile WiMAX MIMO system. The measurements are EVM,
constellation and etc.
e WMAN_M_DL_MIMO_Constellation_RF.dsn: measure downlink MIMO EVM (or RCE) and show the
demodulated constellation.
¢ WMAN_OFDMA_DL_MIMO_Waveform.dsn: measure downlink MIMO transmitter CCDF and waveform.
e WMAN_OFDMA_UL_MIMO_Waveform.dsn: measure uplink MIMO transmitter CCDF and waveform.
. Mobile_ WiMAX_MIMO_Rx_prj
This library provides receiver test benches of Mobile WiMAX MIMO systems. The receiver measurements are
BER/PER on fading channel and etc.
e WMAN_OFDMA_DL_MIMO_Fading_BER.dsn: measure downlink MIMO 2x2 BER/PER in 2x2 ITU fading
environment.
e WMAN_OFDMA_DL_STC_Fading_BER.dsn: measure downlink STC 2x1 BER/PER in 2x1 ITU fading
environment.
e WMAN_OFDMA_UL_MIMO_Fading_BER.dsn: measure uplink two-user collaborative SM BER/PER in 2x2 ITU
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fading environment.

Revision History

1. 2005A.401 - December 2005 (Initial release, obsoleted by 2005A.402)
Initial release of mobile WiMAX 802.16 OFDMA wireless library.
2. 2005A.402-March, 2006
Enhancement and bugs fixed:
e CTC interleaving supports IEEE 802.16-2004/Cor1/D5.
Update the DL_MAP IE from IEEE 802.16e/D8 to IEEE 802.16-2004/Corl/D5.
Update downlink receiver to support from over-sampling ratio 1 to over-sampling ratio 32.
Update uplink PUSC sub channel permutation.
Update downlink optional FUSC sub channel permutation.
3. 2005A.403-April, 2006
Bugs fixed:
e Update DCD to support various Rate ID (such as CC QPSK 1/2, CC QPSK 3/4, CC 16-QAM 1/2, CC 16-QAM
3/4, CC 64-QAM 1/2, CC 64-QAM 2/3, CC 64-QAM 3/4 and etc.).
e Update WMAN_M_DL_SubcarrRandomizer to output the correct subcarrier randomizer sequence (PRBS)
when ZoneNumOfSym>32.
4. 2005A.404-June, 2006
Enhancement:
e Add uplink ranging, fast-feedback and HARQ-ACK channels to support IEEE 802.16e-2005.
e Provide top level downlink/uplink sources with ranging. These top level models are
WMAN_M_DL_Src_Ranging, WMAN_M_UL_Src_Ranging, WMAN_M_DL_Src_Ranging_RF and
WMAN_M_UL_Src_Ranging_RF.
e Add new IEs (FAST-FEEDBACK allocation IE, CDMA ranging and BW request allocations IE and etc.) to
WMAN_M_UL_MAP.
e Use the time windowing filter (WMAN_M_SymWindow) instead of RRC filter (RaisedCosineCx) in both
downlink and uplink sources
e Modify the parameters setting for test benches in WMAN_16e_OFDMA_Tx_prj and
WMAN_16e_OFDMA_Rx_prj to meet IEEE 802.16e-2005.
Bugs fixed:
¢ Remove WMAN_M_UL_FregSyncFraction from WMAN_M_UL_Receiver.
¢ Update the maximum survivor length in WMAN_M_ ViterbiDecoder when Rate_ID = 3 or 6.
5. 2006A.405 -January, 2007
Enhancement:
e Provide STC 2x1 and MIMO 2x2 sources and receivers for downlink.
¢ Provide collaborative SM 1x2 and MIMO 2x2 sources and receiver for uplink.
e Provide STC 2x1 source for uplink.
¢ Update test benches to support WiMAX Forum Mobile Radio Conformance Tests (MRCT).
¢ Update documents with online help and application notes for test benches.
¢ Provide wireless test benches (WTB) for both downlink and uplink.
¢ Provide three power definition methods for downlink sources
e Provide two power definition methods for uplink sources.
e Support compressed DL/UL MAP.
e Support full IEs defined in UL_MAP (see WMAN_M_ULMAP_Full).
Bugs fixed:
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e Update the power scale for Preamble.
6. 2006U2.406 with ADS2006 Update Release 2 - May, 2007
Enhancement:
e Provided CTC decoders for both downlink and uplink receivers.
¢ Updated downlink sensitivity measurement test bench to support MRCT.
e Provided mapping from DIUC/UIUC to Rate ID in all the downlink sources.
e Update uplink data subchannel rotation with HARQ ACK burst according to P802.16-2004/Cor2/D2.
e Added a parameter ChEstimator in WMAN_M_DL_MIMO_Constellation_RF to allow RF Interference
measurement.
Bugs fixed:
e Fixed a bug in the downlink zone permutation with STC/MIMO mode.
¢ Fixed bugs in repetition code field, symbol offset field with STC zone in DL-MAP messages.
¢ Removed pilots in unused slots of UL ACK and FFB bursts.
¢ Updated uplink ranging codes generator in the case that the starting code number is 255 when using two or
three consecutive ranging codes.
7. 2006U3.407 - Sep, 2007
Enhancement:
e Update MIMO channel (WMAN_M_Channel_MIMO) to support MRCT.
¢ Add downlink MIMO (SM)) sensitivity measurement test bench to support MRCT.
¢ Add downlink STC sensitivity measurement test bench to support MRCT.
¢ Add downlink MIMO transmitter measurement test bench connected with VSA 89600.
e Update all the MIMO BER/FER measurement test benches with nhew WiMAX MIMO channel.
e Add a parameter STC_PwrRatio in WMAN_M_DL_2Ant_Src_RF for adjusting the power ratio between
non-STC zone and STC zone.
Bugs fixed:
e Fix a bug about memory leakage in WMAN_M_DL_DemuxOFDMSym_M.
e Fix a bug in WMAN_M_DL_STCDecoder and WMAN_M_UL_STCDecoder when the input signal is very low.
8. 2008A.408 - Jan, 2008
Enhancement:
e Add new sources (WMAN_M_DL_Src_AllCoded and WMAN_M_DL_Src_AllCoded_RF) in which all the bursts
are encoded and the allocation for DL-MAP and UL-MAP is more flexible.
e Update the test bench WMAN_OFDMA_DL_VSA with the new RF source.

WiMedia Wireless Library

Introduction

The Agilent EEsof WiMedia Wireless Library follows WiMedia Multiband OFDM Physical Layer Specification Release 1.1.
This design library is an update to the UWB Wireless Library and it is intended to be a baseline system for designers to
get an idea of what a nominal or ideal system performance would be. Evaluations can be made regarding degraded
system performance due to system impairments that may include nonideal component performance.

New Features
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DCM (Dual-Carrier Modulation) is supported

DCM, which is applied to improve system performance for data rate higher than 200Mpbs in fading scenario has
been included in this update release.

PLCP header update

Reed-Solomon encoding, which is used to guarantee reliable header transmission is included in this release.

. Optional BandGroup #2, #3, #4,#5 and #6

Besides the mandatory Bandgroup #1, all the other optional bandgroups are supported including the Bandgroup
#6, which will be used to support the High Speed BlueTooth.

Three new RX examples are provided

New examples are provided to test The WLAN 11a and WiMax interference to the WiMedia receiver and the ADC
effect.

EVM model update

The one-pin EVM model is update to show consistent results with the instruments.

Notes For UWB Wireless Library User

Since this library is an update of UWB library, it will overwrite the UWB Wireless Library if it exists. Designs that work
with UWB Design Library will also work with WiMedia Library.

Known Issues

The ADC effect example shows slight difference in constellation measurement among multi-platforms. This is because
the very small difference on different platforms is enlarged by ADC quantization when the small difference happens to
be on the decision point.

WLAN 11N Wireless Library

Top Level Models

1.

2.

Top-level baseband signal sources and RF signal sources are provided. WLAN 11n signals can be generated using
these top-level signal source models by setting their parameters. It's very easy for customers to use. The
functionalities are as follows:

e 20/40 MHz bandwidth

e Up to 4 antennas
Mixed Mode and Green Field Mode
¢ Direct mapping and Spatial expansion
800ns GI and 400ns GI
From MCS 0 to MCS 31
Top-level baseband receivers and RF receivers are provided. Corresponding to top-level signal sources, all these
top-level receiver models have the same parameters as that of the signal source models. With these models,
customers can create their system measurements very easily.
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Test Benches

The WLAN 11n Wireless Library provides test benches of WLAN 11n transmitter and receiver. Two projects
(WLAN_11n_Tx_prj, WLAN_11n_Rx_prj) are provided in this WLAN 11n Wireless Library.

1. WLAN_11n_Tx_prj
This project provides transmitter test benches for WLAN 11n. The transmitter performance measurements
include CCDF Spectrum, and EVM measurement.
e WLAN_11n_CCDF.dsn: CCDF measurement
e WLAN_11n_Spectrum.dsn: Spectrum measurement
e WLAN_11n_EVM.dsn: EVM measurement
2. WLAN_11n_Rx_prj
This project provides receiver test benches for WLAN 11n. The receiver measurements include BER/PER under
AWGN and 11n MIMO fading channel.
e WLAN_11n_AWGN_System_2SS.dsn: 2 spatial streams BER/PER performance under AWGN Channel
e WLAN_11n_Fading_System_1SS: 1 spatial stream BER/PER performance under 11n MIMO fading Channel
e WLAN_11n_Fading_System_2SS.dsn: 2 spatial streams BER/PER performance under 11n MIMO fading
Channel

Known issues

There is some difference in EVM measurement on the Linux platform compared to other platforms when the bandwidth
of the input 11n signal is 40MHz. It is recommended to set the EVM model parameter SearchLength between 2-burst
duration to 4-burst duration in this case on Linux platform.

There is also some difference in EVM measurement on Sun 64bit Platform.

There is some slight difference for the output of 11n channel ModelType F between Linux and other platforms. But this
difference will not influence the channel statistical characteristics and will not influence the BER/PER measurement.

Revision History

1. 2005A.402 - Mar. 2006
Initial release of WLAN 11n wireless library.
2. 2005A.403-Jul. 2006
Enhancement and bug fixing:
e Resolve the Circuit Envelope co-simulation issue.
Update the parameter table for the MCS31, 40MHz bandwidth case
Update the MIMO channel to resolve the Linux platform inconsistency issue
Update CCDF range check to report error message when the number of output point is too small
e Update HT-SIG to support the EWC 1.27.
3. 2006A.403-Jan. 2007
Migration to ADS 2006A and later versions
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3GPP LTE Wireless Library

Introduction

The Agilent EEsof 3GPP LTE Wireless Library (WL) is for the 3GPP Long Term Evolution market. This wireless library
follows 3GPP TS 36.211 V8.0.0 (2007-09), TS 36.212 v8.0.0 (2007-09) and their latest change requests R1-074832
and R1-075037. This 3GPP LTE wireless library is intended to be a baseline system for designers to get an idea of
what a nominal or ideal system performance would be.

With this library, you can develop and refine algorithms at the system level, where design choices have the greatest
impact. The 3GPP LTE signal processing algorithms help you move quickly to implementation. Using seamless links to
other Advanced Design System (ADS) options, in particular analog/RF circuits and DSP implementation, you quickly
verify your design based on specification.

The 3GPP LTE WL is an Agilent Ptolemy add-on package based on Advanced Design System 2008.

The 3GPP LTE WL package includes basic 3GPP LTE components, application examples, as well as all software needed
to run in Advanced Design System. After installation, the 3GPP LTE WL is available in the Signal Processing Schematic
window from the "LTE" library group and palette.

The 3GPP LTE application Examples are available from the Main window by choosing File > Example Project >
examples/LTE.

Top Level Models

e Top-level baseband coded signal source and RF coded signal source for downlink was provided. The various
downlink signal source can be generated using these top-level signal source models by setting their parameters.
The new features and upgrade features of DL are as follows:

° PDSCH channel coding/decoding.

° Update PDCCH allocation, PDCCH can be allocated per each subframe. Its number of OFDM symbol will be
0,1, 2 and 3.

© S-SCH update: S-SCH definition based on R1-074832.

° 0Odd number of Tx RB, RB numbering and removal of Partial Unused RB from both Subframe 0 and 5.

° Remove frame structure 1 TDD mode because FS1 TDD was dropped after Jeju (Korea) 3GPP TSG RAN
WG1 Meeting #51 in November.

e Top-level baseband coded signal source and RF coded signal source for uplink was provided. The various uplink
signal source can be generated using these top-level signal source models by setting their parameters. The
update and new features of UL are as follows:

° Add a parameter to transmit PUCCH or not, default value is "NO".

° update PUSCH DMRS definition for DMRS Len >=36 based on R1-074832.

° update PUSCH DMRS definition for DMRS Len < 36 based on R1-074832.

° Update uplink PUSCH channel coding/decoding based on R1-075037.

° Remove frame structure 1 TDD mode because FS1 TDD was dropped after Jeju (Korea) 3GPP TSG RAN
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WG1 Meeting #51 in November.

Test Benches

The 3GPP LTE Wireless Library provides test benches of DL Transmitter measurements, DL coded BER test, UL
transmitter measurements and UL coded BER test. Four projects (LTE_DL_Rx_prj, LTE_DL_Tx_prj, LTE_UL_TX_prj
and LTE_UL_Rx_prj) are provided in this 3GPP LTE WL.

e LTE_DL_Rx_prj
This project provides receiver test benches of 3GPP LTE downlink FDD system. The raw BER (un-decoded BER)
and coded BER of downlink system are provided.
° LTE_DL_RawBER.dsn: Downlink Raw BER and PER Measurement on AWGN Channel.
° LTE_DL_AWGN_BER.dsn: Downink coded BER and PER Measurement on AWGN Channel.
° LTE_DL_Fading_BER.dsn: Downlink coded BER and PER Measurement on fading Channel.
e LTE DL_Tx_prj
This project provides transmitter test benches of 3GPP LTE downlink FDD system. The transmitter measurements
are EVM, constellation, spectrum and CCDF and etc.
° LTE_DL_to_ESG.dsn: Demo how to download BS waveform to ESG Instrument.
° LTE_DL_TxEVM.dsn: BS EVM vs physical channel and resource block measurements.
° LTE_DL_TxEVM_vs_SC.dsn: BS EVM vs subcarrier measurement.
° LTE_DL_TxSpectrum.dsn: BS Tx spectrum, waveform, CCDF and power measurements.

e LTE _UL_Rx_prj
This project provides receiver test benches of 3GPP LTE uplink FDD system. The raw (un-coded) BER and coded
BER of uplink system are provided.
° LTE_UL_RawBER.dsn: Uplink Raw BER and PER Measurement on AWGN Channel.
° LTE_UL_AWGN_BER.dsn: Uplink FDD coded BER and PER Measurement on AWGN Channel.
° LTE_UL_Fading_BER.dsn: Uplink FDD coded BER and PER Measurement on fading Channel.

e LTE_UL_Tx_prj
This library provides transmitter test benches of 3GPP LTE uplink FDD system. The transmitter measurements
are constellation, spectrum and CCDF and etc.
° LTE_UL_1UE_to ESG.dsn: Demo how to download UE waveform to ESG Instrument.
° LTE_UL_1UE_Tx.dsn: 1 UE Tx spectrum, constellation and CCDF measurements.
° LTE_UL_2UE_Tx.dsn: 2 UEs Tx spectrum, constellation and power measurements.
° LTE_UL_TxEVM.dsn: Uplink EVM vs physical channel and resource block measurements.
° LTE_UL_TxEVM_vs_SC.dsn: Uplink EVM vs subcarrier measurement.
° LTE_UL_TxWaveform.dsn: Uplink transmitter waveform measurement.

Revision History

e 2006A.403 - December 2006
Initial release of 3GPP LTE and just including downlink and uplink transmitter
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2006U.404- Feb, 2007
Enhancement:
© Support 12 subcarriers physical resource block size for both downlink/uplink.
° Develop downlink un-decoded receiver.
° Develop downlink EVM measurement.
° Update uplink to support Normal CP and Extended CP like downlink.

2006U.405- May, 2007
Enhancement:
° Update uplink source to support 7 SC-FDMA symbols and 6 SC-FDMA symbols for Normal CP and Extended
CP, respectively.
° Develop uplink un-decoded receiver.
° Develop uplink EVM measurement.
° Update downlink Reference Signal (Pilots) generate to follow TS36.211 v1.0.0.

2006U1.406dev1- June, 2007

Enhancement:
° Update new resource block for both DL/UL transceivers.
° Support partial resource block of odd number of RB.
© Support TDD mode in both DL/UL transceivers.

2006U1.406dev2 or 2006U2.406dev2- July, 2007
Enhancement:

° Update P-SCH generator.

° Implement M-sequence S-SCH.

° Partial RB support.

° new allocation of P-BCH

2006U2.406 (Beta release in EESOF KC) - July, 2007
Enhancement:

° Update P-SCH generator.

° Implement M-sequence S-SCH.

° Partial RB support.

° new allocation of P-BCH

2006U1.407dev1 or 2006U2.407dev1 - July, 2007
Enhancement:
° Update P-SCH generator followed 36.211 v1.2.1.
° Bug fix of partial RB support of odd RBs.
° new allocation of P-BCH followed TS36.211 v1.2.1

2006U1.407dev2 or 2006U2.407dev2 - August, 2007
Enhancement:
° Update UL source to follow 36.211 v1.2.1.
° PUCCH is in edge of resource block and is filled QPSK.
° UL reference signal upgrade to follow TS36.211 v1.2.1
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e 2006U1.407dev3 or 2006U2.407dev3 - Sept, 2007
Enhancement:
° Bug fix for UL SC-FDMA mapper.

e 2006U2.408dev1l - Oct, 2007
Enhancement:
° Update DL and UL based on TS36.211 v8.0.0.

e 2006U2.408dev2 - Nov, 2007
Enhancement:
° Update DL and UL based on TS36.211 v8.0.0, 36.212 v8.0.0 and their latest change requests.
e 2008A.408 - Jan, 2008
° Update DL and UL based on TS36.211 v8.0.0, 36.212 v8.0.0 and their latest change requests.

Ultrawideband (UWB) Design Library is replaced by WiMedia Wireless Library

The Ultrawideband Design Library has been replaced by the WiMedia Wireless Library. Customers who own the UWB
Design Library may request an upgrade to the WiMedia Wireless Library, which is based on the WiMedia 1.1
specification. It is a superset of the UWB Design Library and thus contains all of the UWB models, ensuring
compatibility with existing simulations built using the UWB Design Library. The pulsed-based UWB DesignGuide that
was part of the UWB Design Library is included with ADS 2006A and will not be part of the WiMedia Wireless Library.

Connection Manager Known Issues

On Windows XP, Connection Manager Server fails if Toshiba bluetooth driver installed

EDA00187795 — On Windows XP, the Connection Manager Server can fail if the Toshiba bluetooth driver is installed.
Workaround:

Uninstall the "Bluetooth Stack for Windows by Toshiba". Although the Bluetooth Stack for Windows by Toshba is
uninstalled, XP still provides a Bluetooth capability. So, the alternative Bluetooth is still there.

Connection Manager Server cannot be installed on 64-bit machines

Connection Manager Server must be installed on a true 32-bit machine and will not operate properly in 32-bit
compatibility mode on 64-bit machines.

Instrument Server Known Issues
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Instrument connectivity using the Instrument Server supported on PC only

Though the Connection Manager is recommended for ADS instrument connectivity, ADS continues to support legacy
instrument interfaces like the instrument server and older instrument components but only on PC platforms.

The instrument server and older instrument components rely on the older SICL IO library for instrument connectivity.
Because of this, instrument connectivity through the instrument server and older instrument components is supported
on PC platforms only. The Instrument Server only exists on Windows platforms. However, data file translation
capabilities are available in a new application, the Data File Tool.

Improper reading of units in Time Domain measurements

EDA00184476 — The instrument server currently does not support time domain measurements from a network
analyzer. If you attempt to enter these measurements, the stop/start units will be returned as Hz, when they should
be in seconds.

Printing/Plotting Known Issues

Color images printed in black and white

Xprinter cannot print color graphics saved as EPS, PCL4, or PCL5 files. Try printing directly to the LaserJet 5M printer
or assign the 5M to FILE instead of printer.

Printed and screen colors differ

The HP Color Laserlet printer has problems printing color hardcopy from UNIX installations using Xprinter if the PCL
Cartridge driver is selected. The colors in the hardcopy produced using this driver do not match those displayed on the
monitor.

Workaround:

Use the Color Laserlet PS driver when generating color hardcopy or print in monochrome.

"Print to File" does not work properly when the destination directory is read-only

EDA00181724 — "Print to File" does not work properly when the destination directory is set to read-only. In this case,
a file is not generated and no error or warning message is displayed.

Workaround:

Make sure the destination directory is not read only.
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More information about this issue may be found by referrmg to the Agilent EEsof Knowledge Center at:

The Print Setup Dialog may cause a crash on RedHat Enterprise v3 machines under certain circumstances

EDA00181733 — Bringing up the Print Setup dialog on RedHat Enterprise v3 machines may cause the application to
crash under certain circumstances. This has only been observed once, but the root cause for this failure has not yet

been identified.
More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:

https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Hardcopy.442

RFIP Encoder Known Issues

Internal warning message displayed on ADS2006A console/telnet window

On UNIX based platforms:

While encoding designs using RF IP Encoder an internal message "expander server died" is displayed on the window
where ADS 2008 is started. This message is a warning and for internal use only and does not give any useful

information to the user. It can be simply ignored.

On Windows platform:

While encoding designs using RF IP Encoder an internal message "expander server died" is printed on the log window
(e.g., C:/ADS2003C/bin/hpads.exe -d daemon.log, this command enables log window). This message is a warning and
for internal use only and does not give any useful information to the user. It can be simply ignored.

DesignGuides Known Issues

Bluetooth DesignGuide example TEST_PLL_SS will not converge

EDA00190825 — Prior to ADS 2008, the Bluetooth DesignGuide example TEST_PLL_SS will not converge.

Workaround:
On the HB controller's Solver tab, under Matrix Solver, change the Solver Type from Auto Select to Krylov. The design
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included with ADS 2008 incorporates this change.

IBIS Model Design Library produced by the IBIS Model Import DesignGuide is no longer supported

EDA00192875 — The Design Libraries created with the IBIS Model Import DesignGuide are no longer supported in
ADS 2008.

Workaround:

Use the new IBIS components for IBIS models.

IBIS Model Importer is no longer supported

EDA00191671 — The IBIS Model Importer is no longer the supported method for creating or using IBIS models, so
the IBIS Application Guide is removed from ADS.

Mixed unit types may be created following Yield Optimization

EDA00190825 & EDA00183013 — When using the Filter DesignGuide or Impedance Matching Tool to perform Yield
Optimization, a parameter may be updated following the optimization with mixed unit types, (e.g., the nominal value
is in pF but the optimization range values are in fF). This will cause a warning message to be issued and the schematic
window to show the network.

Workaround:

To correct this, edit the component making the units consistent and re-save the design. The DesignGuide can now be
used with the corrected network.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=DesignGuides.860

Context-sensitive help not enabled for all DesignGuide commands

If you are using the cascading menu configuration on the PC and attempt to access the context-sensitive help ( Help >
What's This? ) for a command, you may not get the requested information. Context-sensitive help is not enabled for a
number of DesignGuide commands. Please refer directly to the documentation for the DesignGuide for the desired
information.

Missing help for DesignGuide subnetworks

Many DesignGuide schematics contain subnetworks. If the subnetwork has no modifiable parameters, no online help is
available for it.

DeveloperStudio issues
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e EDA00184539 — The Palette Editor does not update the display of an edited bitmap until you log out and restart
ADS (UNIX only)

e EDA00177862 — There is a refresh problem in the Content Browser. If you map content to a subnetwork
collector, it only displays the first nine characters in the subnetwork name. If you collapse the subnetwork
collector, and re-open it, then the full name is displayed.

e EDA00177725 — SUN OS-If you are editing the Palette Name in the Palette Editor, and you press the down
arrow on the keyboard, it produces an error.

e EDA00177722 — Report Summary for Palette (and others) has a sizing problem; it is not able to show all of the
information without cutting off some text.

DeveloperStudio limitations not documented

e EDA00177569 — The bitmap viewer in the dialog Insert Palette Item is not as wide as the window will permit. It
wraps the bitmaps to a second row.

e EDA00180380 — The preview feature of the Bitmap Editor only works on the PC.

e EDA00185514 — The Palette Editor Insert Palette Item/Change Caption feature is only available on the PC.

e The Content Editor does not allow file browsing, so the source ADS projects must reside at the top level of
$HOME, and the starting HTML files must reside at the top level of studio_files/<project_name>/doc.

e EDA00177726 — UNIX-The background colors for the window pick up the user settings and do not use the ADS
window colors. This sometimes makes the user interface difficult to view. The default background colors work
best.

e EDA00179138 — After using the Menu Editor to make a change in the name of a menu, there is a delay in the
time it takes menus to respond after being selected.

RF System DesignGuide WCDMA Forward Link design simulates incorrectly on Linux

EDA00180285 — The WCDMA Forward Link test bench in the RF System DesignGuide does not simulate correctly on

the Linux platform.

Workaround:

Correct results may be obtained using other supported platforms.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Simulation.10078

Documentation Search Known Issues

For Linux SLES 9.3 64-bit systems, the Search function in Help does not work

EDA00186078 — For Linux SLES 9.3 64-bit systems (also known as SuSE), the Search function in Help will not work if
the web browser and Java Runtime Engine have not been properly installed.

Workaround:
As a 64-bit Java plug-in is not yet available for this type of system, it is necessary to install 32-bit versions of both.
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For the browser, install the 32-bit Mozilla browser from SuSE, and for the Java engine, install the 32-bit JRE 1.6.0_3
from Sun Microsystems.

Partial word queries

Using a partial word for a query entry could prevent the search engine from finding any matches. For example, when
you perform a query, use a complete term such as hpeesofsim because no matches will be found for eesofsim.

Boolean operators are not allowed in searches for exact phrases

EDA00183401 — When searching for an exact phrase, Boolean operators (AND, NOT, OR) are not allowed in the
query. For example, the exact phrase "design and display" is not allowed, and the following message will appear:
"Bad query. Not expected in phrase: and."

Workaround:

Try to reformulate your query using an alternate syntax such as:

design NEAR display

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Learning Prd.4407

Running a second search in the Documentation window causes an error

EDA00183452 — When you run a search using the entry box available in the Documentation window, a Search
window appears with the results. On UNIX, if you run a second search in the Documentation window (not in the
Search window), a JavaScript error appears: "Search applet undefined".

Workarounds:

e When the Search window is open, run any additional searches from the Search window.
e If you prefer running additional searches from the Documentation window, close the Search window first, or click
Reload in the Documentation window's toolbar, then run the search.

Documentation Search errors may occur on WinXP SP2 systems with local ADS installations

EDA00182134 — In certain cases, documentation search errors may occur on Windows XP SP2 systems if you are
logged in as a local user without administrator privileges.

Workarounds:
¢ Use a different web browser such as Netscape or Mozilla Firefox.
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e Have administrator privileges enabled for you.
More information about this issue may be found by refernng to the Agilent EEsof Knowledge Center at:

. Change the security settmgs in Internet Explorer 6x. In thls case, the foIIowmg steps may resolve the problem:
1. Open IE 6.x.

Choose Tools > Internet Options.

Click the Security tab.

Click the Local Intranet icon.

Click the Sites button.

Click the Advanced button.

Enter http://eesof.tm.agilent.com in the " Add this Web site to the Zone " field.

Click the Add button.

Accept the changes to the preceding dialogs by selecting OK for each.

RN WN

Advanced Search fails when using IE 6 on XP SP2

You may encounter problems with the advanced search option if you are using Internet Explorer 6 on Windows XP
SP2.

Workaround:

Install the Java Runtime Environment (or virtual machine) from Sun at:

http://www.java.com/en/download/windows ie.jsp

If you do this from within a company firewall and encounter problems, use the "offline" installation option available on
the the following website:

http://www.java.com/en/download/manual.jsp

Be sure to read the instructions on the website and use their tool to verify your installation once it completed.

Documentation/Online Help Known Issues

Pull down menu does not list Library Builder

EDA00193192 — The Library Builder is only available from the main ADS documentation window. It cannot be
accessed from the pull down menus at the top of each book.

Workaround:

Use search or select Advanced Design System Documentation from the breadcrumb trail at the top of each page, then
select Library Builder from the main ADS documentation window.

PDF files cannot be searched

EDA00193190 — If you try to search for a word in the documentation PDF files, search will fail to produce any results.
You will not get an error message but no instances of any word will be found.
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Help Topic is not displayed when using Internet Explorer 7

When Help is invoked (by clicking a Help button or Shift-clicking a component button) and a browser window is not
already open, the beginning of the book is displayed instead of the correct topic. When Help is invoked with an open
browser window, the documentation opens correctly.

This only happens on Windows when using Internet Explorer 7 as the default browser.
If you don't wish to change your default browser, use the following steps to display Help on a topic.

1. Invoke Help (click Help button or Shift-click component button) to launch the browser.
2. Invoke Help again, after front page of documentation is displayed, to display the topic.

Limitations when using Automated Transient Assisted Harmonic Balance

When using TAHB, you should be aware of the following limitations:

1. There is a rare case in which the automatic frequency divider detection could fail to identify the presence of a
frequency divider. The case is when the circuit contains a frequency divider and there is a source operating on
not only a harmonic of a fundamental tone, but also the fundamental tone itself. In this case, TAHB will not be
performed if TAHB is set to Auto, because the simulator would think there were no frequency dividers involved.
The workaround is to set TAHB to On.

2. In ADS, TAHB is not supported for multiple HB controllers in a circuit. TAHB can be performed for only one HB
controller.

Specifically:
e The simulation will exit with an error message if more than one HB controller has TAHB set to On. This is
the same as in ADS 2005A.
e If only one HB controller has TAHB set to On and others have TAHB set to either Auto or Off, TAHB will be
performed only for the one with TAHB set to On.
¢ If more than one HB controller has TAHB set to Auto, the simulator will turn off TAHB silently and proceed.

3. TAHB is not supported for Optimization, Yield, Yield Optimization, or DOE. If TAHB is set to On for any of these
analyses, the simulation will exit with an error message. This is the same as in ADS and RFDE 2005A. If TAHB is
set to Auto, the simulator will turn off TAHB silently and proceed.

Hyperlinks to PDF files do not work on Windows machines using Internet Explorer 6x

In Microsoft Windows machines running Internet Explorer 6.x, there may be no response when a hyperlink to a PDF
file is selected.

Occasionally this occurs because Acrobat Reader is not configured to open PDF files within the browser. (To check,
open Acrobat Reader, click Edit > Preferences > Options, and make sure that the checkbox Display PDF in Browser is
selected.) However, that is not usually the cause of the problem.
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If PDF files will not open in the Internet Explorer browser, the problem is usually caused by a conflict between Adobe
Acrobat and the security features of the browser. Although it is often possible to eliminate the problem by means of
configuration changes, this approach is time-consuming and does not always work.

It is usually preferable to solve this problem by either of two methods:
¢ Use a different application (such as Netscape or Mozilla Firefox) as your default browser.

e Right-click on the link to the PDF file, and choose Save Target As from the right-click menu to save a local copy
of the PDF file.

If you don't wish to use these solutions, you may be able to eliminate the problem by means of the reconfiguration
procedures outlined below. More information about this issue may be found by referring to the Agilent EEsof
Knowledge Center at:

https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Learning Prd.4529

Reconfiguring your Windows XP or 2000 machine, as described below, may make it possible for PDF files to open in
Internet Explorer 6.0. If this approach does not succeed, see the other solutions described above.

Reconfiguring your PC to read PDF files from a local installation of ADS

© Note

Before making these modifications, please review the following Microsoft support documents:
http://support.microsoft.com/kb/315933/en-us?spid=2073&sid=global
http://support.microsoft.com/kb/182569/
http://support.microsoft.com/default.aspx?scid=kb;en-us;833633

Configure XP to Display the My Computer Web Content Zone in the IE Tools Internet Options Security tab.

1. From the Windows task bar, choose Start > Run to open the Run dialog.

2. In the Run dialog, enter regedi t and click OK.

3. In the Registry Editor, click on the [+] buttons to open subfolders and browse to the following registry key
folder:
HKEY_CURRENT_USER > Software > Microsoft > Windows > CurrentVersion > Internet Settings > Zones > 0 .

4. In the Registry Editor, " Name " column, double-click Flags.

In the Edit DWORD Value dialog, change the Value data : from 21 to 47 and click OK.

6. In the Registry Editor, choose File > Exit.

b

Configure IE Internet Options "Advanced" Settings (Windows XP only).

From the Windows task bar, choose Start > Internet (Internet Explorer) to open Internet Explorer (IE).
In IE, choose Tools > Internet Options.

In the Internet Options dialog, click the Advanced tab.

Scroll down to the Security section and select the " Allow active content to run in files on My Computer "
checkbox.

Sl
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5. In the Internet Options dialog, click Apply.
Configure IE Internet Options "Security" Settings.

In the Internet Options dialog, click the Security tab.

In the " Select a Web content zone to specify its security settings ", click My Computer.

In the Security level for this zone group, click Custom Level.

In the Security Settings dialog Reset custom settings group Reset to: drop-down list, choose Medium and click
Reset.

In the " Warning! Are you sure you want to change security settings for this zone?" dialog, click Yes.

In the Security Settings dialog, click > OK.

In the Internet Options dialog, click > OK.

Close all instances of Internet Explorer.

il
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Note

If you still cannot open PDFs, repeat Steps 1 through 8 under Configure IE Internet Options Security Settings
above. If that does not solve the problem, use a different application as the default browser, or right-click on
the PDF hyperlink and choose Save Target As.

Reconfiguring your browser to view PDFs on the Web

On some machines there is a problem with the security settings in Internet Explorer 6x. In this case, the following
steps may resolve the problem:

Open IE 6.x.

Choose Tools > Internet Options.

Click the Security tab.

Click the Local Intranet icon.

Click the Sites button.

Click the Advanced button.

Enter http://eesof.tm.agilent.com in the " Add this Web site to the Zone " field.
Click the Add button.

Accept the changes to the preceding dialogs by selecting OK for each.

WOINOUAWN R

© Note

If you still cannot open PDFs, use a different application as the default browser, or right-click on the PDF
hyperlink and choose Save Target As.

On Linux Systems, PDF Files May Not Open Using the Mozilla Browser.

This happens because the Mozilla browser expects the PDF application to be in a specific location, and this may not be
the case. To solve this problem, modify the location of the PDF application specified in the browser settings. This
modification will be retained for future use.
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Platform Specific Known Issues

F11 and F12 function keys don't work on Solaris

EDA00113439 — In order for the F11 and F12 keys to work on a Sun machine, the keys must be mapped as follows
from a terminal window:

F11'
F12'

xnodmap -e ' keysym SunF36
xmodmap -e ' keysym SunF37

Other Known Issues

The layers used for export after performing an export from Allegro is reset to the full layer list

When a subset of layers has been defined for export from Allegro to ADS this subset of layers is not maintained after
an export from Allegro and is reset to the complete layer list.

The selection of a limited layers list must be done before each export Allegro to have to correct set of exported layers.
Allegro Design Flow Integration ignores Anti Etch lines used to split negative layers

The Allegro Design Flow integration ignores Anti Etch Class objects in Allegro. These Anti Etch objects are typically
used to create split layer structures inside negative layers in an Allegro design. As a result of this limitation, all objects
defined using split lines in a negative layer will be shorted together in the transfer from Allegro to ADS.

Parallel key users may have to run FLEXidInstaller.exe and select Flexid 6/7 and 8

EDA00109099 — Parallel key users may have to run FLEXidInstaller.exe and select Flexid 6/7 and 8. The older version
of the dongle key drivers is located in the \dongle_sup directory on the installation CD.

More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:
https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Installation.1712

Using Mozilla 1.7 Browser on UNIX or Linux Platforms
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Starting with the 2006A release, it is recommended that you use a modern browser such as Mozilla 1.7 on UNIX and
Linux platforms to use EEsof EDA product documentation.

Your browser should have the Adobe Reader (Acrobat) and Java Runtime Environment (JRE) plugins installed and
working. You should also have the path to the Adobe Reader executable, acroread, in your login's PATH.

You can check which plugins are installed by entering the following URL in your browser:

about : pl ugi ns

If you have Mozilla 1.7 installed on your machine, you can use it by setting the EESOF_BROWSER environment
variable to point to the full path of your browser executable. For example:

EESOF_BROWSER=/ usr/ bi n/ nozil | a
export EESOF BROASER

If you don't have Mozilla installed, do the following:

1. On Solaris, download and install the Mozilla Suite for Solaris 8 or 9 from the Sun Microsystems web site. Mozilla
1.7 is included with Solaris 10:
http://www.sun.com/software/solaris/browser/index.xml
On HP UX, download and install Mozilla for HP-UX from the Hewlett-Packard web site:
htt www.hp.com/productsl/unix/java/mozilla/index.html?jumpid=reg R1002 USEN

On Llnux download and install the latest Mozilla browser from:
http://www.mozilla.org/download.html
Plugins are available from:
http://plugindoc.mozdev.org/linux.html

2. Verify you have a working Mozilla browser installation, with AdobeAcrobat and the latest JRE. That is, you should
be able to run Mozilla and be able to open PDF files.

3. Make sure acroread is in your PATH. For instance, if you installed Adobe Acrobat into /usr/local/Acrobat, be sure
your PATH includes:

RATH=/ usr/ | ocal / Acr obat / bi n: $PATH
dxport PATH

4. Set EESOF_BROWSER to point to your Mozilla browser:

BESOF_BROWSER=/ usr /| ocal / npzill a/ mozil |l a
gxport EESOF_BROASER

5. Start ADS:

HPEESOF_ DI R=/ usr /| ocal / ads2006a
ATH=$HPEESOF_DI R/ bi n: $PATH
xport HPEESOF_DI R PATH

ds
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6. Now when you request help, your Mozilla browser should open.
Once this is working, you can set the HPEESOF_DIR, EESOF_BROWSER and PATH environment variables in your
account's profile, $HOME/.profile, $HOME/.bash_profile, etc.
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USB hardware key not recognized in PCs using newer Intel chipsets

EDA00182906 — Some USB hardware keys are not recognized with systems using one of Intel's newer chipsets.

Workaround:
To remedy this you need to download the Iatest FLEXid drivers from:

SIV and MDS migration not available in ADS2006A

Both SIV and MDS migration were removed as features in the ADS2005A release.

Workaround:
For SIV migration you can use ADS2004A for the migration, save the design/project and then open it using

ADS2006A.

WLAN_802_11b_TX WTB signal to ESG cannot be demodulated properly using the current default setting

1. EDA00183231 — For RFDE Examples/WLAN/WLAN_WTB_Test, using WLAN_802_11b_TX WTB under the default
setting the signal downloaded to ESGc cannot be demodulated properly. This is because the default value of the
parameter ESG_SampleClkRate is incorrect. This value needs to be set to 66 MHz instead of 80 MHz.

Workaround:
To resolve this problem either change the ESG_SampleClkRate from 80 MHz to 66 MHz in the wtb design, or

change the ARB Sample Clock from 80 MHz to 66 MHz for the ESGc ARB setup.
More information about this issue may be found by referring to the Agilent EEsof Knowledge Center at:

https://edasupportweb.soco.agilent.com/cgi-bin/show.pl?id=Signal Proc.3874
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